L3110 User's Guide
Contents

L3110 User's Guide ..................................................................................................................................... 9

Product Basics .......................................................................................................................................... 10
  Control Panel Buttons and Lights ....................................................................................................... 10
  Product Parts Locations ..................................................................................................................... 10
    Product Parts - Front ..................................................................................................................... 11
    Product Parts - Inside .................................................................................................................... 12
    Product Parts - Back ...................................................................................................................... 14
  Changing the Default Paper Size in the Control Panel ....................................................................... 14
  The Power Off and Sleep Timers ....................................................................................................... 14
    Changing the Power Off and Sleep Timer Settings - Windows ...................................................... 15
    Changing the Power Off and Sleep Timer Settings - Mac .............................................................. 16

Loading Paper ........................................................................................................................................... 17
  Loading Paper in the Sheet Feeder .................................................................................................... 17
  Paper Loading Capacity ..................................................................................................................... 21
  Double-sided Printing Capacity .......................................................................................................... 21
  Compatible Epson Papers .................................................................................................................. 22
  Borderless Paper Type Compatibility ................................................................................................. 24
  Paper or Media Type Settings - Printing Software .............................................................................. 24

Placing Originals on the Product ............................................................................................................. 26
  Placing Originals on the Scanner Glass ............................................................................................. 26

Copying ...................................................................................................................................................... 28
  Copying Documents or Photos ........................................................................................................... 28

Printing from a Computer ......................................................................................................................... 29
  Printing with Windows ....................................................................................................................... 29
    Selecting Basic Print Settings - Windows ....................................................................................... 30
    Print Quality Options - Windows ................................................................................................... 32
    Multi-Page Printing Options - Windows ........................................................................................ 32
    Selecting Double-sided Printing Settings - Windows .................................................................... 33
    Double-sided Printing Options - Windows .................................................................................... 35
    Selecting Additional Layout and Print Options - Windows ........................................................... 35
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom Color Correction Options - Windows</td>
<td>37</td>
</tr>
<tr>
<td>Image Options and Additional Settings - Windows</td>
<td>38</td>
</tr>
<tr>
<td>Header/Footer Settings - Windows</td>
<td>39</td>
</tr>
<tr>
<td>Selecting a Printing Preset - Windows</td>
<td>40</td>
</tr>
<tr>
<td>Selecting Extended Settings - Windows</td>
<td>42</td>
</tr>
<tr>
<td>Extended Settings - Windows</td>
<td>43</td>
</tr>
<tr>
<td>Printing Your Document or Photo - Windows</td>
<td>44</td>
</tr>
<tr>
<td>Locking Printer Settings - Windows</td>
<td>45</td>
</tr>
<tr>
<td>Locked Setting Options</td>
<td>47</td>
</tr>
<tr>
<td>Selecting Default Print Settings - Windows</td>
<td>48</td>
</tr>
<tr>
<td>Changing the Language of the Printer Software Screens</td>
<td>49</td>
</tr>
<tr>
<td>Changing Automatic Update Options</td>
<td>50</td>
</tr>
<tr>
<td>Printing with the Built-in Epson Driver - Windows 10 S</td>
<td>51</td>
</tr>
<tr>
<td>Selecting Print Settings - Windows 10 S</td>
<td>51</td>
</tr>
<tr>
<td>Printing on a Mac</td>
<td>54</td>
</tr>
<tr>
<td>Selecting Basic Print Settings - Mac</td>
<td>55</td>
</tr>
<tr>
<td>Print Quality Options - Mac</td>
<td>58</td>
</tr>
<tr>
<td>Print Options - Mac</td>
<td>59</td>
</tr>
<tr>
<td>Selecting Page Setup Settings - Mac</td>
<td>59</td>
</tr>
<tr>
<td>Selecting Print Layout Options - Mac</td>
<td>60</td>
</tr>
<tr>
<td>Managing Color - Mac</td>
<td>61</td>
</tr>
<tr>
<td>Color Matching and Color Options - Mac</td>
<td>62</td>
</tr>
<tr>
<td>Selecting Printing Preferences - Mac</td>
<td>63</td>
</tr>
<tr>
<td>Printing Preferences - Mac</td>
<td>63</td>
</tr>
<tr>
<td>Printing Your Document or Photo - Mac</td>
<td>64</td>
</tr>
<tr>
<td>Checking Print Status - Mac</td>
<td>65</td>
</tr>
<tr>
<td>Cancelling Printing Using a Product Button</td>
<td>66</td>
</tr>
<tr>
<td><strong>Scanning</strong></td>
<td></td>
</tr>
<tr>
<td>Starting a Scan</td>
<td>67</td>
</tr>
<tr>
<td>Starting a Scan Using the Product Buttons</td>
<td>67</td>
</tr>
<tr>
<td>Changing Default Scan Job Settings</td>
<td>67</td>
</tr>
<tr>
<td>Starting a Scan Using the Epson Scan 2 Icon</td>
<td>68</td>
</tr>
<tr>
<td>Starting a Scan from a Scanning Program</td>
<td>70</td>
</tr>
</tbody>
</table>
Solving Problems

Checking for Software Updates ......................................................................................................................... 111
Product Light Status ....................................................................................................................................... 112
Running a Product Check ................................................................................................................................ 114

Solving Setup Problems ................................................................................................................................... 116
Noise After Filling the Ink ................................................................................................................................. 116
Software Installation Problems ..................................................................................................................... 116

Solving Copying Problems ................................................................................................................................. 117
Product Makes Noise, But Nothing Copies ........................................................................................................ 117
Product Makes Noise When It Sits for a While ................................................................................................. 117

Solving Paper Problems ................................................................................................................................... 117
Paper Feeding Problems .................................................................................................................................. 118
Paper Jam Problems ......................................................................................................................................... 118
Paper Ejection Problems .................................................................................................................................. 121

Solving Problems Printing from a Computer ....................................................................................................... 122
Nothing Prints .................................................................................................................................................. 122
Product Icon Does Not Appear in Windows Taskbar ....................................................................................... 123
Printing is Slow ................................................................................................................................................ 123

Solving Page Layout and Content Problems .................................................................................................... 125
Inverted Image .................................................................................................................................................. 125
Too Many Copies Print .................................................................................................................................... 126
Blank Pages Print ............................................................................................................................................. 126
Incorrect Margins on Printout .......................................................................................................................... 126
Border Appears on Borderless Prints ............................................................................................................... 127
Incorrect Characters Print ................................................................................................................................ 128
Incorrect Image Size or Position .................................................................................................................... 128
Slanted Printout .................................................................................................................................................. 129

Solving Print Quality Problems .......................................................................................................................... 129
White or Dark Lines in Printout ............................................................................................................................ 130
Blurry or Smeared Printout ............................................................................................................................... 131
Faint Printout or Printout Has Gaps .................................................................................................................... 132
Grainy Printout .................................................................................................................................................. 133
Incorrect Colors ................................................................................................................................................ 134
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trademarks</td>
<td>157</td>
</tr>
<tr>
<td>Copyright Notice</td>
<td>157</td>
</tr>
<tr>
<td>libTIFF Software Acknowledgment</td>
<td>158</td>
</tr>
<tr>
<td>A Note Concerning Responsible Use of Copyrighted Materials</td>
<td>158</td>
</tr>
<tr>
<td>Copyright Attribution</td>
<td>159</td>
</tr>
</tbody>
</table>
L3110 User's Guide

Welcome to the L3110 User's Guide.

For a printable PDF copy of this guide, click here.
Product Basics

See these sections to learn about the basic features of your product.
Control Panel Buttons and Lights
Product Parts Locations
Changing the Default Paper Size in the Control Panel
The Power Off and Sleep Timers

Control Panel Buttons and Lights

1 The power button and light
2 The B&W copy button
3 The color copy button
4 The stop button
5 The ink and paper light

Parent topic: Product Basics

Product Parts Locations

See these sections to identify the parts on your product.
Product Parts - Front
Product Parts - Inside
Product Parts - Back
Parent topic: Product Basics
Product Parts - Front

1  Rear paper feed
2  Paper support
3  Edge guides
4  Feeder guard
5  Output tray

Parent topic: Product Parts Locations
Product Parts - Inside

1  Document cover
2  Scanner glass
3 Control panel

1 Front cover
2 Ink tanks
3 Ink tank unit
4 Ink tank cover
5 Print head

Parent topic: Product Parts Locations
Product Parts - Back

1  AC inlet
2  USB port

Parent topic: Product Parts Locations

Changing the Default Paper Size in the Control Panel

Depending on your region, the default paper size for copies is either A4 (8.3 × 11.7 inches [210 × 297 mm]) or Letter (8.5 × 11 inches [216 × 279 mm]).

- To change the default paper size to A4 (8.3 × 11.7 inches [210 × 297 mm]), make sure the product is turned off, then hold down the color copy button and press the power button to turn the product on. When the product turns on, release both buttons.

- To change the default paper size to Letter (8.5 × 11 inches [216 × 279 mm]), make sure the product is turned off, then hold down the B&W copy button and press the power button to turn the product on. When the product turns on, release both buttons.

Parent topic: Product Basics

The Power Off and Sleep Timers

The product enters sleep mode or turns off automatically if it is not used for a period of time. You can adjust the time period before power management begins, but increasing the time reduces the product's energy efficiency.
Changing the Power Off and Sleep Timer Settings - Windows

You can use the printer software to change the time period before the printer enters sleep mode or turns off automatically.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click . Select Printer Settings and click the Maintenance tab.

2. Click the Printer and Option Information button.

You see this window:

![Printer and Option Information window]

3. Select the time period you want as the Power Off Timer setting.

4. Click Send.

5. Select the time period you want as the Sleep Timer setting.

6. Click Send.

7. Click OK to close the open program windows.

Parent topic: The Power Off and Sleep Timers
Changing the Power Off and Sleep Timer Settings - Mac

You can use the printer software to change the time period before the printer enters sleep mode or turns off automatically.

1. In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select Utility and select Open Printer Utility.
2. Select Printer Settings.
   You see this screen:
   ![Printer Settings Screen]

3. Select the time period you want as the Power Off Timer setting.
4. Select the time period you want as the Sleep Timer setting.
5. Click Apply.
6. If you see the confirmation message, click Yes, and close the Printer Settings window.

Parent topic: The Power Off and Sleep Timers
Loading Paper

Before you print, load paper for the type of printing you will do.

Loading Paper in the Sheet Feeder
Paper Loading Capacity
Double-sided Printing Capacity
Compatible Epson Papers
Borderless Paper Type Compatibility
Paper or Media Type Settings - Printing Software

Loading Paper in the Sheet Feeder

You can print documents and photos on a variety of paper types and sizes.

1. Flip the feeder guard forward, then raise the paper support.

2. Pull out the output tray and open the paper stopper.
3. Slide the edge guides out all the way.

4. If you are inserting a stack of paper, fan the sheets first and tap the stack on a flat surface to even the edges.

Note: Do not fan or curl photo paper.

5. Do one of the following:
   • Insert paper, glossy or printable side up and short edge first, in the center of the paper support.
• Load up to 10 envelopes in the center of the paper support. Load them printable side up and flap edge left.

• Load a sheet of loose-leaf or other paper with holes facing as shown.

• To load a sheet of paper longer than legal size, close the paper support and flatten the leading edge of the paper as shown.
6. Slide the edge guides against the paper, but not too tightly. Then flip the feeder guard back.

Always follow these paper loading guidelines:
• Load only the recommended number of sheets.
• Load paper short edge first, no matter which way your document faces.
• Load letterhead or pre-printed paper top edge first.
• Do not load paper above the arrow mark inside the edge guide.
• If you have trouble loading a stack of envelopes, press each envelope flat before loading it or load one envelope at a time.
• Do not load envelopes that are curled, folded, or too thin, or that have plastic windows or exposed adhesive flaps.
• Check the paper package for any additional loading instructions.
• If you use paper with binder holes, load only one sheet at a time in only these sizes: Letter (8.5 × 11 inches [216 × 279 mm]), A4 (8.3 × 11.7 inches [210 × 297 mm]), or Legal (8.5 × 14 inches [216 × 356 mm]).

Parent topic: Loading Paper

Related references
Paper Loading Capacity
Paper Specifications
## Paper Loading Capacity

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Loading capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm]) or A4 (8.3 × 11.7 inches [210 × 297 mm]) size or smaller: Up to the line indicated by the arrow mark</td>
</tr>
<tr>
<td>Copy paper</td>
<td>Legal (8.5 × 14 inches [216 × 356 mm]) or 8.5 × 13 inches (216 × 330 mm) size: 1 sheet</td>
</tr>
<tr>
<td>Epson Bright White Pro Paper</td>
<td>Up to the line indicated by the arrow mark</td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td>80 sheets</td>
</tr>
<tr>
<td>Epson High Quality Ink Jet Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td>20 sheets</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>If paper feeds incorrectly, or printing is uneven or smeared, load 1 sheet at a time.</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td></td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td></td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td></td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte Double-sided</td>
<td>1 sheet</td>
</tr>
<tr>
<td>Envelopes</td>
<td>10 envelopes</td>
</tr>
</tbody>
</table>

Parent topic: Loading Paper

## Double-sided Printing Capacity

You can print double-sided on the paper types and sizes listed here.
### Compatible Epson Papers

You can purchase genuine Epson ink and paper from an Epson authorized reseller. To find the nearest reseller, visit [epson.com.jm](http://epson.com.jm) or call your nearest Epson sales office.

**Note:** Paper/media availability varies by country.

<table>
<thead>
<tr>
<th>Paper Type</th>
<th>Size</th>
<th>Part number</th>
<th>Sheet count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Bright White Pro Paper Matte Double-sided</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041586</td>
<td>500</td>
</tr>
<tr>
<td>Paper Type</td>
<td>Size</td>
<td>Part number</td>
<td>Sheet count</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>----------------------------------------------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td>Legal (8.5 × 14 inches [216 × 356 mm])</td>
<td>S041067</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>Epson Premium Presentation Paper Matte</td>
<td>S041467</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>8 × 10 inches (203 × 254 mm)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041257</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>Epson High Quality Ink Jet Paper</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A4 (8.3 × 11.7 inches [210 × 297 mm])</td>
<td>S041117</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041111</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>Epson Premium Presentation Paper Matte Double-sided</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041568</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>Epson Photo Paper Glossy</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4 × 6 inches (102 × 152 mm)</td>
<td>S041809</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S042038</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041141</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S041649</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S041271</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>Epson Premium Photo Paper Glossy</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4 × 6 inches (102 × 152 mm)</td>
<td>S041808</td>
<td>40</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S041727</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>16:9 wide (4 × 7.1 inches [102 × 181 mm])</td>
<td>S042109</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>5 × 7 inches (127 × 178 mm)</td>
<td>S041464</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>8 × 10 inches (203 × 254 mm)</td>
<td>S041465</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S042183</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S041667</td>
<td>50</td>
</tr>
</tbody>
</table>
Parent topic: Loading Paper

Borderless Paper Type Compatibility

You can print borderless photos on compatible paper types in compatible sizes:

**Borderless Paper Types**
- Epson Photo Paper Glossy
- Epson Premium Photo Paper Glossy
- Epson Ultra Premium Photo Paper Glossy
- Epson Premium Photo Paper Semi-gloss

**Borderless Paper Size**
- 4 × 6 inches (102 × 152 mm)

Parent topic: Loading Paper

Paper or Media Type Settings - Printing Software

<table>
<thead>
<tr>
<th>Paper Type</th>
<th>Size</th>
<th>Part number</th>
<th>Sheet count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Ultra Premium Photo Paper</td>
<td>4 × 6 inches (102 × 152 mm)</td>
<td>S042181</td>
<td>60</td>
</tr>
<tr>
<td>Glossy</td>
<td></td>
<td>S042174</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>5 × 7 inches (127 × 178 mm)</td>
<td>S041945</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>8 × 10 inches (203 × 254 mm)</td>
<td>S041946</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S042182</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S042175</td>
<td>50</td>
</tr>
<tr>
<td>Epson Premium Photo Paper</td>
<td>4 × 6 inches (102 × 152 mm)</td>
<td>S041982</td>
<td>40</td>
</tr>
<tr>
<td>Semi-gloss</td>
<td></td>
<td>S041331</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

For this paper | Select this paper Type or Media Type setting
--- | ---
Plain paper | Plain Paper / Bright White Paper
Epson Bright White Pro Paper |
<table>
<thead>
<tr>
<th>For this paper</th>
<th>Select this paper Type or Media Type setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Envelopes</td>
<td>Envelope</td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td>Ultra Premium Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>Premium Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td>Premium Photo Paper Semi-Gloss</td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td>Premium Presentation Paper Matte</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td></td>
</tr>
<tr>
<td>Epson High Quality Ink Jet Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte Double-sided</td>
<td></td>
</tr>
</tbody>
</table>

**Parent topic:** Loading Paper
Placing Originals on the Product

Follow the instructions here to place your original documents or photos on the product.

**Caution:** Do not place anything on top of your product or use its cover as a writing surface to avoid damaging it.

Placing Originals on the Scanner Glass

Placing Originals on the Scanner Glass

You can place originals up to this size on the scanner glass: Letter (8.5 × 11 inches [216 × 279 mm]) or A4 (8.3 × 11.7 inches [210 × 297 mm]).

1. Open the document cover.
2. Place your original facedown on the scanner glass with the top facing into the corner. Slide the original to the edges of the indicated corner.

Note: You can place multiple originals on the scanner glass. Just make sure they are at least 0.2 inch (4.5 mm) away from the edge of the scanner glass and at least 0.8 inch (20 mm) away from each other.

Note: The edges of your original may be cropped by 0.06 inch (1.5 mm) from the edge of the scanner glass. Manually position your original away from the edges to prevent cropping.

3. Close the document cover gently to keep your original in place.

Caution: Do not push down on the document cover or scanner glass or you may damage the product.

Remove your originals after scanning. If you leave the originals on the scanner glass for a long time, they may stick to the glass surface.

Parent topic: Placing Originals on the Product

Related topics

Copying
Scanning
Copying

See the information here to copy documents or photos using your product.

Note: Copies may not be exactly the same size as your originals.

Copying Documents or Photos

Copying Documents or Photos
You can copy color or black-and-white documents or photos onto plain paper.

1. Place your original document or photo on the scanner glass.

2. Load plain paper in one of these sizes: Letter (8.5 × 11 inches [216 × 279 mm]) or A4 (8.3 × 11.7 inches [210 × 297 mm]).

3. Do one of the following to start copying:
   - To copy a black-and-white original, press the B&W copy button.
   - To copy a color original, press the color copy button.
   - To copy a black-and-white or color original in draft mode, press the B&W copy button or the color copy button and the stop button at the same time.
   - To make more than one copy, repeatedly press the B&W copy button or the color copy button for the number of copies you need (up to 20 copies). For example, to make 4 copies, press the button four times. Make sure you press the button in intervals of less than one second.

The product scans and prints your copy.

Note: To cancel copying, press the stop button.

Parent topic: Copying

Related tasks
Placing Originals on the Scanner Glass
Loading Paper in the Sheet Feeder
Printing from a Computer

Before printing from your computer, make sure you have set up your product and installed its software as described on the Start Here sheet.

Note: If you have an Internet connection, it is a good idea to check for updates to your product software on Epson's support website. If you see a Software Update screen, select Enable automatic checking and click OK. The update scans your system to see if you have the latest product software. Follow the on-screen instructions.

Printing with Windows
Printing with the Built-in Epson Driver - Windows 10 S
Printing on a Mac
Cancelling Printing Using a Product Button

Printing with Windows

You can print with your product using any Windows application, as described in these sections.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the software described in this section. You also cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

Selecting Basic Print Settings - Windows
Selecting Double-sided Printing Settings - Windows
Selecting Additional Layout and Print Options - Windows
Selecting a Printing Preset - Windows
Selecting Extended Settings - Windows
Printing Your Document or Photo - Windows
Locking Printer Settings - Windows
Selecting Default Print Settings - Windows
Changing Automatic Update Options

Parent topic: Printing from a Computer
Selecting Basic Print Settings - Windows

Select the basic settings for the document or photo you want to print.

1. Open a photo or document for printing.
2. Select the print command in your application.

   **Note:** You may need to select a print icon on your screen, the **Print** option in the **File** menu, or another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use.

   **Note:** You may also need to select **Properties** or **Preferences** to view your print settings.

You see the Main tab of your printer settings window:
4. Select the size of the paper you loaded as the **Document Size** setting.

   **Note:** You can also select the **User-Defined** setting to create a custom paper size.

5. If you are printing a borderless photo, select **Borderless**. You can click **Settings** to access additional options for borderless printing.

   **Note:** You must select a compatible borderless paper type and size to print without borders. Check the borderless paper compatibility list for details.

6. Select the orientation of your document.

   **Note:** If you are printing an envelope, select **Landscape**.

7. Select the type of paper you loaded as the **Paper Type** setting.

   **Note:** The setting may not exactly match the name of your paper. Check the paper type settings list for details.

8. Select the **Quality** setting that matches the print quality you want to use.

9. Select a Color option:
   - To print a color document or photo, select the **Color** setting.
   - To print text and graphics in black or shades of gray, select the **Black/Grayscale** setting.

10. To print on both sides of the paper, select a **2-Sided Printing** option.

11. To print multiple pages on one sheet of paper, or print one image on multiple sheets of paper, select one of the settings in the **Multi-Page** menu and select the printing options you want.

12. To print multiple copies and arrange their print order, select the **Copies** options.

13. To reduce noise during printing when you select **Plain Paper/Bright White Paper**, turn on **Quiet Mode** (printing will be slower).

14. To preview your job before printing, select **Print Preview**.

15. To save your print job as a project that can be modified and combined with other print jobs, select **Job Arranger Lite**.

**Print Quality Options - Windows**

**Multi-Page Printing Options - Windows**
Print Quality Options - Windows
You can select any of the available Quality options to fine-tune the quality of your print. Some settings may be unavailable, depending on the paper type and border setting you have chosen.

Draft
For draft printing on plain paper.

Standard
For everyday text and image printing.

Standard - Vivid
For text and graphics with good quality and print speed.

High
For photos and graphics with high print quality.

More Settings
Opens a window that lets you choose among levels of speed and quality.

Parent topic: Selecting Basic Print Settings - Windows

Multi-Page Printing Options - Windows
You can select any of the available options in the Multi-Page menu to set up your multi-page print job.

Two-Up and Four-Up
Prints 2 or 4 pages on one sheet of paper. Click the Page Order button to select page layout and border options.

Two×One Poster, Two×Two Poster, Three×Three Poster, Four×Four Poster
Prints one image on multiple sheets of paper to create a larger poster. Click the Settings button to select image layout and guideline options.

Parent topic: Selecting Basic Print Settings - Windows
Selecting Double-sided Printing Settings - Windows

You can print on both sides of the paper by selecting one of the **2-Sided Printing** options on the Main tab.

Note: You will need to print one side and flip the paper over manually to print the other side.

Note: Some options may be pre-selected or unavailable, depending on other settings you have chosen.

1. Select one of the following options for **2-Sided Printing**:
   - **Manual (Long-edge binding)** to print your double-sided print job by printing one side and prompting you to flip the paper over on the long edge to print the other side.
   - **Manual (Short-edge binding)** to print your double-sided print job by printing one side and prompting you to flip the paper over on the short edge to print the other side.

2. Click the **Settings** button.
You see a window like this:

3. Select the double-sided printing options you want to use.
4. Click **OK** to return to the Main tab.
5. Print a test copy of your double-sided document to test the selected settings.
6. Follow any instructions displayed on the screen during printing.

**Note:** The surface of the paper may smear during double-sided printing. Make sure the ink has dried before reloading the paper.

**Double-sided Printing Options - Windows**

**Parent topic:** Printing with Windows

**Related tasks**

Selecting Basic Print Settings - Windows
Double-sided Printing Options - Windows

You can select any of the available options on the 2-Sided Printing Settings window to set up your double-sided print job.

Binding Edge Options
Select a setting that orients double-sided print binding in the desired direction.

Binding Margin Options
Select options that define a wider margin to allow for binding.

Booklet
Select the Booklet checkbox to print double-sided pages as a booklet.

Parent topic: Selecting Double-sided Printing Settings - Windows

Selecting Additional Layout and Print Options - Windows

You can select a variety of additional layout and printing options for your document or photo on the More Options tab.
1. To change the size of your printed document or photo, select the Reduce/Enlarge Document checkbox and select one of these sizing options:
   • Select the Fit to Page option to size your image to fit the paper you loaded. Select the size of your document or photo as the Document Size setting, and the size of your paper as the Output Paper setting. If you want to center your image on the paper, select the Center option.
   • Select the Zoom to option to reduce or enlarge your document or photo by a specific percentage. Select the percentage in the % menu.
2. Select one of the following Color Correction options:
   • Select Automatic to automatically adjust the sharpness, brightness, contrast, and color saturation for your image.
   • Select Custom and click the Advanced button to manually adjust the color correction settings or turn off color management in your printer software.
   • Select Image Options to access additional settings for improving printed images.
   **Note:** You can also select Color Universal Print settings.
3. To add the following features, click the Watermark Features button:
   • Anti-Copy Pattern: adds a watermark that only appears when your printout is copied
     **Note:** This setting is not available for all types of printing.
   • Watermark: adds a visible watermark to your printout
     **Note:** Click the Add/Delete button to create your own watermark, and click the Settings button to customize the watermark.
   • Header/Footer: adds information such as the date and time to the top or bottom of your printout
     **Note:** Click the Settings button to customize the text and location of the header or footer.
4. Select any of the Additional Settings options to customize your print.
   Custom Color Correction Options - Windows
   Image Options and Additional Settings - Windows
   Header/Footer Settings - Windows
   **Parent topic:** Printing with Windows
Related tasks
Selecting Basic Print Settings - Windows

Custom Color Correction Options - Windows

You can select any of the available options in the Color Correction window to customize the image colors for your print job.

![Color Correction Window](image)

**Color Controls**

Lets you select a **Color Mode** setting, individual settings for **Brightness**, **Contrast**, **Saturation**, and **Density**, and individual color tones. Depending on the selected color mode, you can also adjust the midtone density using the **Gamma** setting.

**Fix Photo**

Improves the color, contrast, and sharpness of flawed photos.

**Note:** Fix Photo uses a sophisticated face recognition technology to optimize photos that include faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo
includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to retain the special color effects.

ICM
Lets you manage color using installed color printing profiles.

No Color Adjustment
Turns off color management in your printer software so you can manage color using only your application software.

Parent topic: Selecting Additional Layout and Print Options - Windows

Image Options and Additional Settings - Windows
You can select any of the Image Options and Additional Settings to customize your print. Some options may be pre-selected or unavailable, depending on other settings you have chosen.

Image Options

Emphasize Text
Adjusts the weight of printed text to increase readability.

Emphasize Thin Lines
Adjusts the weight of printed lines to increase visibility.

Edge Smoothing
Smoothes jagged edges in low-resolution images such as screen captures or images from the Web.

Fix Red-Eye
Reduces or removes red-eye in photos.

Print Text in Black
Prints colored text in black.

For Color Text
Prints colored text on a background pattern or underlined.

For Color Graphs and Images
Prints colored graphics and images with overlay patterns.

For Color Text, Graphs, and Images
Prints colored text, graphics, and images with overlay patterns.

Enhancement Options
Specifies Color Universal Print enhancement settings for text, graphics, and images.
Additional Settings Options

Rotate 180°
Prints the image rotated 180° from its original orientation.

High Speed
Speeds up printing but may reduce print quality.

Mirror Image
Flips the printed image left to right.

Parent topic: Selecting Additional Layout and Print Options - Windows

Header/Footer Settings - Windows
You can select any of the Header/Footer Settings options to add headers or footers when you print. The items are available to print at the top or bottom of your pages, in either the left, right, or center of the page.

Note: These settings are not saved with your document.

You can select to print the following information:
- User Name
- Computer Name
- Date
- Date/Time
- Document Name
- Collate Number (copy number)
Note: The user name, computer name, date, and time come from the Windows Control Panel on your computer.

Parent topic: Selecting Additional Layout and Print Options - Windows

Selecting a Printing Preset - Windows

For quick access to common groups of print settings, you can select a printing preset on the Main or More Options tab.

Note: You can create your own preset by clicking the Add/Remove Presets button.

1. Click the Main or More Options tab.
You see the available **Printing Presets** on the left:

2. Place your cursor over one of the **Printing Presets** to view its list of settings.
3. Click on a preset to change its settings, or use any of the available options on the screen to control your printing presets.
4. To choose a preset for printing, select it.
5. Click **OK**.
Parent topic: Printing with Windows

Selecting Extended Settings - Windows

You can select additional settings that apply to all the print jobs you send to your product.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click .
2. Select Printer Settings.
3. Click the Maintenance tab.
   You see the maintenance options:

![Maintenance Options]

4. Click the Extended Settings button.
5. Select any of the extended settings to customize your print.
6. Click OK to close the Extended Settings window.
7. Click OK to close the printer software window.

Extended Settings - Windows

Parent topic: Printing with Windows

Extended Settings - Windows

You can select these settings on the Extended Settings window.

**Enable EPSON Status Monitor 3**

Enables product monitoring for ink and paper supplies and other issues.

**Separator Page**

Before each document, prints a separator page containing the title, user, date, and time.

**Remove white borders**

Removes white margins that may appear when you print borderless photos.
Always Spool RAW Datatype
   Increases print speed and may solve other printing problems.

Page Rendering Mode
   Increases print speed when printing is extremely slow or the print head stops during printing.

Print as Bitmap
   Increases print speed when printing is extremely slow or the print head stops during printing, and other settings do not help.

Skip Blank Page
   Ensures that your product does not print pages that contain no text or images.

Change Standard Resolution
   Reduces the resolution of print data to correct printing problems.

Refine screening pattern
   Prints graphics with a finer screening pattern.

Allow Applications to Perform ICM Color Matching
   Allows applications to perform ICM color matching.

Always Use the Driver's Paper Source Setting
   Prints using the paper source setting in the printer driver, rather than the setting in your application.

Barcode mode
   Reduces bleeding when printing barcodes on plain paper, letterhead paper, recycled paper, preprinted paper, envelopes, and thick paper.

Parent topic: Selecting Extended Settings - Windows

Printing Your Document or Photo - Windows

Once you have selected your print settings, you are ready to save your settings and print.

1. Click OK to save your settings.
You see your application's Print window, such as this one:

![Print window](image)

2. Click **OK** or **Print** to start printing.

**Parent topic:** Printing with Windows

**Related tasks**

Selecting Basic Print Settings - Windows  
Locking Printer Settings - Windows

### Locking Printer Settings - Windows

Windows administrators can lock access to some printer settings to prevent unauthorized changes.

1. Do one of the following:

   - **Windows 10:** Click 📱 and select 📦 (Settings) > Devices > Printers & scanners. Select your product name and select **Manage** > **Printer properties**.
   
   - **Windows 8.x:** Navigate to the **Apps** screen and select **Control Panel** > **Hardware and Sound** > **Devices and Printers**. Right-click your product and select **Printer properties**.
• **Windows 7**: Click 🌠 and select Devices and Printers. Right-click your product and select Printer properties.

• **Windows Vista**: Click 🌠 and select Control Panel. Click Printer under Hardware and Sound, then right-click your product and select Properties.

2. Click the Optional Settings tab.

   **Note**: You can prevent access to the Optional Settings tab by changing the user or group permissions in the Security tab.

3. Click Driver Settings.

   You see this window:

   ![Driver Settings Window](image)

4. Select the checkbox for each setting you want to lock. To lock all print settings, select All Document Settings.

5. Under Advanced Settings, select the setting option you want to use for each locked setting.
6. Click **OK**.

**Locked Setting Options**

**Parent topic:** Printing with Windows

**Locked Setting Options**

Select the options you want to use for any locked print settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anti-Copy Pattern</td>
<td>Various data items</td>
<td>Lets you select the data to use for the pattern or prohibit anti-copy patterns</td>
</tr>
<tr>
<td>Add/Delete</td>
<td></td>
<td>Lets you add or delete a customized anti-copy pattern</td>
</tr>
<tr>
<td>Settings</td>
<td></td>
<td>Lets you select the arrangement, size, and other settings for the custom anti-copy pattern</td>
</tr>
<tr>
<td>Watermark</td>
<td>Various text watermarks</td>
<td>Lets you select the text for the watermark or prohibit watermarks</td>
</tr>
<tr>
<td>Add/Delete</td>
<td></td>
<td>Lets you add or delete a customized text or image-based watermark</td>
</tr>
<tr>
<td>Settings</td>
<td></td>
<td>Lets you select the size, position, color and other watermark settings</td>
</tr>
<tr>
<td>Header/Footer</td>
<td>Off</td>
<td>Prohibits headers or footers</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>Allows headers and footers</td>
</tr>
<tr>
<td></td>
<td>Settings</td>
<td>Lets you select the text and position for printing headers and footers</td>
</tr>
<tr>
<td>Color</td>
<td>Color</td>
<td>Allows color printing</td>
</tr>
<tr>
<td></td>
<td>Grayscale</td>
<td>Allows printing in black or shades of gray only</td>
</tr>
<tr>
<td>Multi-Page</td>
<td>Off</td>
<td>Prohibits multi-page settings</td>
</tr>
<tr>
<td></td>
<td>2-Up</td>
<td>Allows printing of 2 pages on one sheet of paper</td>
</tr>
<tr>
<td></td>
<td>4-Up</td>
<td>Allows printing of 4 pages on one sheet of paper</td>
</tr>
</tbody>
</table>

**Parent topic:** Locking Printer Settings - Windows
Selecting Default Print Settings - Windows

When you change your print settings in a program, the changes apply only while you are printing in that program session. If you want to change the print settings you use in all your Windows programs, you can select new default print settings.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click .
2. Select Printer Settings.
   You see the printer settings window:

   ![Printer Settings Window]

3. Select the print settings you want to use as defaults in all your Windows programs.
4. Click OK.

These settings are now the defaults selected for printing. You can still change them as needed for printing in any program session.
Changing the Language of the Printer Software Screens

Parent topic: Printing with Windows

Related tasks
Selecting Basic Print Settings - Windows

Changing the Language of the Printer Software Screens

You can change the language used on the Windows printer software screens.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click.

2. Select Printer Settings.
   You see the printer settings window.

3. Click the Maintenance tab.
   You see the maintenance options:
4. Select the language you want to use as the **Language** setting.
5. Click **OK** to close the printer software window.

The printer software screens appear in the language you selected the next time you access them.

**Parent topic:** Selecting Default Print Settings - Windows

### Changing Automatic Update Options

Your printer software for Windows automatically checks for updates to the product software. You can change how often the software checks for updates or disable this feature.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click .
2. Select **Software Update Settings**.

   You see this window:

   ![Software Update Settings](image)

3. Do one of the following:
   - To change how often the software checks for updates, select a setting in the **Check every** menu.
   - To disable the automatic update feature, select the **Never** option.
4. Click **OK** to exit.

**Note:** If you choose to disable the automatic update feature, you can check for updates manually.
Parent topic: Printing with Windows
Related tasks
Checking for Software Updates

Printing with the Built-in Epson Driver - Windows 10 S
You can print with the built-in Epson printer driver using any printing program on Windows 10 S, as described in these sections.

Note: The built-in Epson driver in Windows 10 S does not include all the available print settings for your product. To print with additional settings, download and install the Epson Print and Scan utility from the Windows Store. You cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

Related tasks
Selecting Print Settings - Windows 10 S
Parent topic: Printing from a Computer

Selecting Print Settings - Windows 10 S
Select the settings for your print job in your Windows 10 S application.
1. Open a photo or document for printing.
2. Select the print command in your application.

   **Note:** You may need to select a print icon on your screen, the **Print** option in the **File** menu, or another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use.

   **Note:** You may also need to select **Properties** or **Preferences** to view your print settings.
You see a window like this:

![Epson ESC/P-R V4 Class Driver Printing Preferences window]

4. Select the type of paper you loaded as the **Media** setting.
   
   **Note:** The setting may not exactly match the name of your paper. Check the paper type settings list for details.

5. Click the **Advanced** button.
You see a window like this:

6. Select the size of the paper you loaded as the **Paper Size** setting.
7. To print multiple copies, select or enter the number as the **Copy Count** setting.
8. To print multiple copies of multi-page documents in sets, select the **Collated** checkbox.
9. Click **OK**.

You return to the printing preferences window.
10. Select the **Layout** tab.

![](Epson_ESC-P-R_V4_Class_Driver_Printing_Preferences.png)

11. Select the orientation of your document as the **Orientation** setting.

12. Click **OK** to save your settings.

   You see your application’s **Print** window.

13. Click **OK** or **Print** to start printing.

**Parent topic:** Printing with the Built-in Epson Driver - Windows 10 S  
**Related references**  
Paper or Media Type Settings - Printing Software

---

**Printing on a Mac**

You can print with your product using any Mac printing program, as described in these sections.

**Note:** If you have an Internet connection, it is a good idea to check for updates to your product software on Epson’s support website.
Selecting Basic Print Settings - Mac
Selecting Page Setup Settings - Mac
Selecting Print Layout Options - Mac
Managing Color - Mac
Selecting Printing Preferences - Mac
Printing Your Document or Photo - Mac

Parent topic: Printing from a Computer

Selecting Basic Print Settings - Mac

Select the basic settings for the document or photo you want to print.

1. Open a photo or document for printing.
2. Select the print command in your application.

   Note: You may need to select a print icon on your screen, the Print option in the File menu, or another command. See your application's help utility for details.

3. Select your product as the Printer setting.

4. If necessary, click the arrow next to the Printer setting or the Show Details button to expand the print window.
You see the expanded printer settings window for your product:

Note: The print window may look different, depending on the Mac OS version and the application you are using.

5. Select the **Copies** and **Pages** settings as necessary.

   **Note:** If you do not see these settings in the print window, check for them in your application before printing.

**Note:** If you do not see these settings in the print window, check for them in your application before printing. They may be accessible by selecting Page Setup from the File menu.

7. Select any application-specific settings that appear on the screen, such as those shown in the image above for the Preview application.

8. Select **Print Settings** or **Printer Features** from the pop-up menu.

You see these settings:
9. Select the type of paper you loaded as the **Media Type** setting.

   **Note:** The setting may not exactly match the name of your paper. Check the paper type settings list for details.

10. Select the **Print Quality** setting you want to use.
11. Select the **Borderless** checkbox if you want to print a borderless photo. If the option is grayed out, change the **Media Type** setting to a paper type that supports borderless printing.
12. Select any of the available print options.

   - **Print Quality Options - Mac**
   - **Print Options - Mac**
   - **Parent topic:** Printing on a Mac

   **Related references**
   - **Paper or Media Type Settings - Printing Software**
   - **Related tasks**
   - **Selecting Page Setup Settings - Mac**

**Print Quality Options - Mac**

You can select any of the available Print Quality options to fine-tune the quality of your print. Some settings may be unavailable, depending on the paper type setting you have chosen.

- **Draft**
  - For draft printing on plain paper.
- **Normal**
  - For everyday text and image printing.
- **Normal - Vivid**
  - For everyday text and image printing with good quality and print speed.
- **Fine**
  - For text and graphics with good quality and print speed.
- **Quality**
  - For text and graphics with increased quality and print speed.
- **High Quality**
  - For photos and graphics with high print quality.
- **Best Quality**
  - For the best print quality, but the slowest print speed.
Print Options - Mac
You can select any of the print options to customize your print. Some options may be unavailable, depending on other settings you have chosen.

Expansion
If you selected a borderless paper size setting, this option adjusts the image expansion settings to control printing at the edges of borderless prints.

Grayscale
Prints text and graphics in black or shades of gray.

Mirror Image
Lets you flip the printed image horizontally.

Note: If you select the Min option for the Expansion setting, you may see white borders on your printed photo.

Parent topic: Selecting Basic Print Settings - Mac

Selecting Page Setup Settings - Mac
Depending on your application, you may be able to select the paper size and orientation settings from the print window.

Note: If you do not see these settings in the print window, check for them in your application before printing. They may be accessible by selecting Page Setup from the File menu.

1. Select the size of the paper you loaded as the Paper Size setting. If you are printing a borderless photo, select the Borderless checkbox or a paper size with a Borderless option. You can also
select a custom setting to create a custom paper size, but the Quality setting will be limited to Normal.

Note: You must select a compatible borderless paper type and size to print without borders. Check the borderless paper compatibility list for details.

2. Select the orientation of your document or photo as shown in the print window.

Note: If you are printing an envelope, select the icon.

Note: You can reduce or enlarge the size of the printed image by selecting Paper Handling from the pop-up menu and selecting a scaling option.

Parent topic: Printing on a Mac
Related tasks
Selecting Basic Print Settings - Mac
Selecting Print Layout Options - Mac

Selecting Print Layout Options - Mac
You can select a variety of layout options for your document or photo by selecting Layout from the pop-up menu on the print window.
• To print multiple pages on one sheet of paper, select the number of pages in the Pages per Sheet pop-up menu. To arrange the print order of the pages, select a Layout Direction setting.
• To print borders around each page on the sheet, select a line setting from the Border pop-up menu.
• To print on both sides of each page, select a setting from the Two-Sided pop-up menu.
• To invert or flip the printed image, select the Reverse page orientation or Flip horizontally settings.

Parent topic: Printing on a Mac

Managing Color - Mac

You can adjust the Color Matching and Color Options settings to fine-tune the colors in your printout or turn off color management in your printer software.

1. Select Color Matching from the pop-up menu in the print window.

2. Select one of the available options.

3. Select Color Options from the pop-up menu in the print window.
Note: The available settings on the Color Options menu depend on the option you selected on the Color Matching menu.

4. Select one of the available options.

Color Matching and Color Options - Mac

Parent topic: Printing on a Mac

Color Matching and Color Options - Mac

You can select these settings on the Color Matching and Color Options menus.

Color Matching Settings

EPSON Color Controls

Lets you manage color using controls in your printer software or turn off color management.

ColorSync

Prints using standard color profiles for your product and paper to help match image colors. You can customize the conversion method and filter settings on the ColorSync pop-up menu in the print window.

Color Options Settings

Manual Settings

Lets you select manual color adjustments. Click the arrow next to Advanced Settings and select settings for Brightness, Contrast, Saturation, and individual color tones. You can also select a color Mode setting for printing photos and graphics and the Fix Red-Eye setting to reduce or remove red-eye in photos. Depending on the selected color mode, you can also adjust the midtone density using the Gamma setting.

Fix Photo

Improves the color, contrast, and sharpness of flawed photos. Click the arrow next to Advanced Settings and select the Fix Red-Eye setting to reduce or remove red-eye in photos.

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to retain the special color effects.

Off (No Color Adjustment)

Turns off color management in your printer software so you can manage color using only your application software.
Note: An ICC profile is required if color management is turned off.

Parent topic: Managing Color - Mac

Selecting Printing Preferences - Mac

You can select printing preferences that apply to all the print jobs you send to your product.

1. In the Apple menu or the Dock, select System Preferences.
2. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options & Supplies.
3. Select Driver or Options.
   You see a screen like this:

   ![Printing Preferences Screen]

   To take full advantage of your printer’s options, confirm that they are accurately shown here. For information on your printer and its optional hardware, check the printer’s documentation.

   - Skip Blank Page: Off
   - Quiet Mode: Off
   - High Speed Printing: On
   - Remove white borders: Off
   - Warning Notifications: On
   - Establish bidirectional communication: On

4. Select any of the available printing preferences.
5. Click OK.

Printing Preferences - Mac

Parent topic: Printing on a Mac

Printing Preferences - Mac

You can select these settings on the Options or Driver tab.
Skip Blank Page  
Ensures that your product does not print pages that contain no text or images.

Quiet Mode  
Lessens noise during printing but may decrease print speed.

High Speed Printing  
Speeds up printing but may reduce print quality.

Remove white borders  
Removes white margins that may appear when you print borderless photos.

Warning Notifications  
Lets you choose whether or not to receive warning notifications from the printer software for various operating conditions.

Establish bidirectional communication  
Allows the product to communicate with the computer. Do not change the default setting unless you experience issues when using a shared printing pool.

Parent topic: Selecting Printing Preferences - Mac

Printing Your Document or Photo - Mac  
Once you have selected your print settings, you are ready to print.
Click **Print** at the bottom of the print window.

### Checking Print Status - Mac

**Parent topic:** Printing on a Mac

**Related tasks**
- Selecting Basic Print Settings - Mac

**Checking Print Status - Mac**

During printing, you can view the progress of your print job, control printing, and check ink status.

1. Click the printer icon when it appears in the Dock.
You see the print status window:

![Print Status Window](image)

2. Select the following options as necessary for your Mac OS version:
   - To cancel printing, click the print job and click x or **Delete**.
   - To pause a print job, click the print job and click ■ or **Hold**. To resume a print job, click the paused print job and click ■ or **Resume**.
   - To pause printing for all queued print jobs, click **Pause** or **Pause Printer**.
   - To display other printer information, click **Settings** or **Supply Levels**.

Parent topic: Printing Your Document or Photo - Mac

**Cancelling Printing Using a Product Button**

If you need to cancel printing, press the ☐ stop button.

Parent topic: Printing from a Computer
Scanning

You can scan your originals and save them as digital files.

Starting a Scan
Scanning in Epson Scan 2

Starting a Scan

After placing your originals on your product for scanning, start scanning using one of these methods.

Starting a Scan Using the Product Buttons
Starting a Scan Using the Epson Scan 2 Icon
Starting a Scan from a Scanning Program

Parent topic: Scanning

Starting a Scan Using the Product Buttons

You can scan an image and save it as a PDF using your product’s control panel buttons. You can change the default scan settings using the Event Manager utility on the computer.

1. Make sure you installed the product software and connected the product to your computer using a USB cable.

2. Press the \(^{\text{B&W}}\) B&W copy button and the \(^{\text{Color}}\) color copy button at the same time.
   Your original is scanned and saved as a PDF on your computer.

Changing Default Scan Job Settings

Parent topic: Starting a Scan

Related tasks
Scanning in Epson Scan 2

Changing Default Scan Job Settings

You can view or change the default scan job settings your product uses when you scan to your computer. You do this using the Event Manager program.

1. Do one of the following to open Event Manager:
   - **Windows 10**: Click \(\text{Start}\) and select \text{Epson Software} > \text{Event Manager}.
   - **Windows 8.x**: Navigate to the Apps screen and select \text{Event Manager}. 
• **Windows (other versions):** Click  or Start > All Programs or Programs > Epson Software > Event Manager.

• **Mac:** Open the Applications folder, click Epson Software, and select Event Manager.

2. Open the Scanner (Windows) or Select Scanner (Mac) drop-down list and select your product, if necessary.

3. Click **Make Job Settings**.

4. Open the Edit Job Settings drop-down list and select the scan job settings you want to view or change.

5. Change the settings as necessary.

6. Click **OK**.

7. Click **Close** to close the Event Manager window.

**Parent topic:** Starting a Scan Using the Product Buttons

### Starting a Scan Using the Epson Scan 2 Icon

You can start the Epson Scan 2 program to select scan settings, scan, and save the scanned image to a file.

**Note:** If you are using your Epson product with the Windows 10 S operating system, you cannot use the software described in this section. You also cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

• **Windows 10:** Click  and select EPSON > Epson Scan 2.

• **Windows 8.x:** Navigate to the Apps screen and select Epson Scan 2.

• **Windows (other versions):** Click  or Start, and select All Programs or Programs. Select EPSON > Epson Scan 2 > Epson Scan 2.

• **Mac:** Open the Applications folder, open the Epson Software folder, and select Epson Scan 2.
You see an Epson Scan 2 window like this:
Starting a Scan from a Scanning Program

You can start Epson Scan 2 from a TWAIN-compliant scanning program to select scan settings, scan, and open the scanned image in the program.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the software described in this section. You also cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

1. Open your scanning program and select its scanning option. (See your scanning program help for instructions.)
2. Select your product.

Note: In certain programs, you may need to select your product as the "source" first. If you see a Select Source option, choose it and select your product. With Windows, do not select a WIA option for your product; not all scan functions will be available.
You see an Epson Scan 2 window like this:
Epson Scan 2 gives you access to basic and advanced scanning features. You can scan your document and save the scanned image in various file formats in your operating system’s Documents or My Documents folder, or open it in your scanning program. You can preview the scanned image and select or change settings as necessary.

**Note:** If you are using your Epson product with the Windows 10 S operating system, you cannot use the software described in this section. You also cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

1. Start Epson Scan 2.
You see this window:
2. Select the **Mode** setting that matches the type of original you are scanning.

3. Select the **Document Source** setting that matches where you placed your original.

4. Select the **Document Size** setting that matches the size of your original. You can select **Customize** to enter a custom size, if necessary.

5. Select the image type of your original and how you want it scanned as the **Image Type** setting.

6. Select the **Resolution** setting you want to use for your scan.

7. Click the **Preview** button.
   
   Epson Scan 2 previews your original and displays the results in the Epson Scan 2 window.

8. Do one of the following:
   - If you’re scanning in Document Mode, select any of the additional settings that you want to use on the Main Settings tab.
   - If you’re scanning in Photo Mode, select the **Color Management** and **Thumbnail Options** settings as necessary.

9. Click the **Advanced Settings** tab and select any settings that you want to use.
10. Select the format in which you want to save your scanned file as the **Image Format** setting. If necessary, select **Options** and select any desired format options.

11. Enter the file name for your scanned file in the **File Name** field. If necessary, select **Settings** to modify the file name settings.

12. Select the location in which you want to save your scanned file as the **Folder** setting. If necessary, select **Select** to create a new folder.

13. Click **Scan**.

   The product scans your original and saves the scanned file in the location you specified.

**Additional Scanning Settings - Main Settings Tab**

You can select these additional scanning settings on the Epson Scan 2 Main Settings tab. Not all adjustment settings may be available, depending on other settings you have chosen.

**Rotate**

Rotates the original image clockwise to the desired angle before scanning it. Select **Auto** to allow your product to automatically rotate the image based on the orientation of the text (may take longer to scan).

**Correct Document Skew**

Corrects skewed originals, image contents, or both.

**Add or edit pages after scanning**

Lets you add, remove, or edit the pages in a scan, including rotating pages and changing the page order.

**Note:** To save multiple pages in a single file, you must select a file format that supports multiple pages such as PDF or Multi-TIFF. If you select another file format, each scanned image or page is saved as a separate file.
Additional Scanning Settings - Advanced Settings Tab

You can select these additional scanning settings on the Epson Scan 2 Advanced Settings tab. Not all adjustment settings may be available, depending on other settings you have chosen.

**Remove Background**
Removes the background of the originals.

**Text Enhancement**
Sharpens the appearance of letters in text documents.

**Auto Area Segmentation**
Makes black and white images clearer and text recognition more accurate by separating the text from the graphics.

**Threshold**
Adjusts the level at which black areas in text and line art are delineated, improving text recognition in OCR (Optical Character Recognition) programs.

**Color Enhance**
Enhances the shades of the color you select in the scanned image. This setting is available only if you select **Grayscale** or **Black & White** as the Image Type setting.

**Brightness**
Adjusts the overall lightness and darkness of the scanned image.

**Contrast**
Adjusts the difference between the light and dark areas of the overall scanned image.

**Gamma**
Adjusts the midtone density of the scanned image.

**Unsharp Mask**
Makes the edges of certain image areas clearer. Turn off this option to leave softer edges.

**Descreening**
Removes the ripple pattern that might appear in subtly shaded image areas, such as skin tones. This option improves results when scanning magazines or newspapers. (The results of descreening do not appear in the preview image, only in your scanned image.)

**Edge Fill**
Corrects shadowing around the edges of the image by filling the shadows with black or white.

**Dual Image Output**
Scans the original image twice using different output settings (Windows only).

Parent topic: Scanning in Epson Scan 2
Saving Scanned Documents as a Searchable PDF Using Epson Scan 2

You can scan a document and save the text in a searchable PDF. In a searchable PDF, text is recognized using Optical Character Recognition (OCR) and then embedded in the scanned original.

**Note:** The required Epson Scan 2 OCR Component is installed automatically when you install your product software as instructed on the *Start Here* sheet. If you install your scanner software programs individually, be sure to also install this component if you want to perform OCR.

1. Load your original in the product for scanning.
2. Start Epson Scan 2.
3. Select your scan settings.
4. Click **Preview** and adjust the area you want to scan, if necessary.
5. Select **Searchable PDF** as the Image Format setting.
6. Select **Options** from the Image Format list.

You see this window:
7. Select any of the options on the **General** tab.
8. Select the **Text** tab.
9. Make sure the language used in the document text is selected as the **Text Language** setting.
10. Select the **Security** tab if you want to add a password to the PDF or protect printing or editing properties.
11. Click **OK**.
12. Confirm the **File Name** setting and select a **Folder** setting for your document.
13. Click **Scan**.
   The scanned image is saved as a searchable PDF.

**Parent topic:** [Scanning in Epson Scan 2](#)

### Image Format Options

You can select different image formats and related options. For details on available options, click the ? icon on the Epson Scan 2 Image Format Options window. Not all image formats have options.

- **BITMAP (***.bmp**)**
  A standard image file format for most Windows programs.

- **JPEG (***.jpg**)**
  An image format that lets you highly compress image data. However, the higher the compression, the lower the image quality. (The TIFF format is recommended when you need to modify or retouch your scanned image.)

- **PNG (***.png**)**
  An image format that does not lose quality during editing.

- **TIFF (***.tif**)**
  A file format created for exchanging data between many programs, such as graphic and DTP software.

- **Multi-TIFF (***.tif**)**
  A TIFF file format when multiple pages are saved to the same file, allowing you to edit the images using a compatible program.

- **PDF (***.pdf**)**
  A document format that is readable by Windows and Mac systems using Adobe Reader, Acrobat, or other programs. You can save multi-page documents in one PDF file.
**Searchable PDF (*.pdf)**

A document format that is readable by Windows and Mac systems using Adobe Reader, Acrobat, or other programs. You can save multi-page documents in one PDF file. Recognized text in the scanned document can be searched.

**Parent topic:** Scanning in Epson Scan 2

---

**Scan Resolution Guidelines**

The **Resolution** setting, measured in dpi (dots per inch), controls the amount of detail captured in your scans. Increasing the resolution raises the amount of detail captured but comes with the following disadvantages:

- Larger file sizes
- It takes longer to scan your originals, send/receive your scans by email or fax, and to print your scans
- The image may become too large to fit on your display or print on paper

If you plan to enlarge a scanned image so you can print it at a larger size, you may need to increase the resolution from the default resolution set by Epson Scan 2. Follow these guidelines to determine the resolution setting you need:

- You will scan the image at its original size but enlarge it later in an image-editing program.
  
  Increase the Epson Scan 2 Resolution setting in your scan. Increase the resolution by the same amount you will increase the image size to retain a high image quality. For example, if the resolution is 300 dpi (dots per inch) and you will double the image size later, change the Resolution setting to 600 dpi.

- You will scan the image at 100% or a smaller size.
  
  Select the Epson Scan 2 Resolution setting based on how you will use the scanned image:
  
  - Email/view on a computer screen/post on the web: 96 to 200 dpi
  - Print/fax/convert to editable text (OCR)/create searchable PDF: 200 to 300 dpi

**Parent topic:** Scanning in Epson Scan 2
Refilling Ink

When the ink level is below the lower line on an ink tank, you need to refill it.
Before checking the ink levels or refilling an ink tank as described here, be sure to read the ink safety precautions.

Caution: If the ink level is below the lower line on the ink tank, fill it to the upper line on the ink tank. Continued use of the product when the ink level is below the lower line on a tank could damage the product.

Ink Safety Precautions

Ink Handling Precautions
- Keep ink bottles and the ink tanks out of the reach of children. Do not allow children to drink from or handle the ink bottles and bottle caps.
- Do not tilt or shake an ink bottle after opening it; otherwise, ink may leak.
- If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes, flush them immediately with water. If ink gets into your mouth, spit it out and see a doctor right away.
- Do not squeeze the ink bottles.

Ink Refilling Precautions
- Use ink bottles with the correct part number for this product.
- Do not mix with other Epson ink types.
- The use of non-Epson ink may cause damage that is not covered by Epson’s warranty, and under certain circumstances, may cause erratic product behavior.
- This product requires careful handling of ink. Ink may splatter when the ink tanks are filled or refilled with ink. If ink gets on your clothes or belongings, it may not come off.
• Do not open the ink bottle package until you are ready to fill an ink tank. Ink bottles are vacuum packed to maintain reliability. If you leave an ink bottle unpacked for a long time before using it, print quality may be affected.

• If the ink level is below the lower line on the ink tank, refill the ink. Continued use of the product when the ink level is below the lower line on the ink tank could damage the product.

• After bringing an ink bottle inside from a cold storage site, allow it to warm up at room temperature for at least three hours before using it.

• Store ink bottles in a cool, dark place.

• Store the ink bottles in the same environment as the product. When storing or transporting an opened ink bottle, do not tilt the bottle and do not subject it to impacts or temperature changes. Otherwise, ink may leak even if the cap on the ink bottle is tightened securely. Be sure to keep the ink bottle upright when tightening the cap, and take measures to prevent ink from leaking when you transport the bottle.

Ink Bottle and Ink Tank Information

• To maintain optimum print head performance, some ink is consumed from all ink tanks during printing and when performing maintenance operations, such as cleaning the print head.

• The ink bottles may contain recycled materials, but this does not affect product function or performance.

• The specification and appearance of the ink bottles are subject to change without prior notice for improvement.

• When printing in monochrome or grayscale, color ink may be used instead of black ink, depending on the paper type or print quality settings. This is because a mixture of color inks is used to create black.

Parent topic: Refilling Ink

Checking Ink Levels on Your Product

To confirm the actual ink levels, visually check the ink levels in the product’s ink tanks. Make sure the ink levels are above the lower lines on the ink tanks.
Disabling Special Offers with Windows

You can disable special offers messages from Epson using a utility on your Windows computer.

**Note**: You may see the Epson Special Offers screen every time you print (if your computer is connected to the Internet). Select **Do not display this message again** and click **Decline** to disable online offers. Promotional offers are not valid in Latin America.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click icon. Select **Monitoring Preferences**.
You see this window:

2. To disable promotional offers, deselect the **Display Epson Offers** checkbox.

**Parent topic:** Refilling Ink

**Purchase Epson Ink**

You can purchase genuine Epson ink and paper from an Epson authorized reseller. To find the nearest reseller, visit [epson.com.jm](http://epson.com.jm) or call your nearest Epson sales office.
**Note:** This product is designed to work with genuine Epson inks. Non-Epson ink or any other ink not specified for this printer could cause damage not covered by Epson's warranties.

The ink bottles that are used for initial product setup have a lower yield due to the ink charging process. This process is carried out the first time you turn on the printer and guarantees better performance. Yields vary considerably based on print jobs, print settings, paper type, frequency of use, and temperature. Do not load paper before refilling the ink tanks.

Check the ink levels in your product frequently, and refill the ink tanks if necessary.

**Ink Bottle Part Numbers**

**Parent topic:** Refilling Ink

**Ink Bottle Part Numbers**

Use these part numbers when you order or purchase new ink bottles, and use the ink by the date printed on the package:

<table>
<thead>
<tr>
<th>Ink color</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>544</td>
</tr>
<tr>
<td>Cyan</td>
<td>544</td>
</tr>
<tr>
<td>Magenta</td>
<td>544</td>
</tr>
<tr>
<td>Yellow</td>
<td>544</td>
</tr>
</tbody>
</table>

**Parent topic:** Purchase Epson Ink

**Refilling the Ink Tanks**

Make sure you have new ink bottles handy and have read the ink safety precautions before you begin. You can continue to use the product even if one or more ink tanks are not filled all the way.

**Caution:** Wear disposable gloves while refilling the ink tanks to avoid staining your hands. If ink spills, wipe it off immediately with a damp towel to avoid permanent stains. If ink gets on your clothes or belongings, it may not come off.
1. Open the ink tank cover.

2. Open the cap for the ink tank you are going to fill.

Note: Make sure the color of the ink tank label matches the ink color you want to fill.
3. Hold the ink bottle upright and slowly turn the bottle cap to remove it.

Caution: Do not shake or squeeze the bottle. Do not touch the top of the bottle after removing its cap.

Warning: If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes, flush them immediately with water. If ink gets into your mouth, spit it out and see a doctor right away. Seek medical advice if problems persist. Keep the ink bottles out of the reach of children and do not drink the ink.
4. Position the top of the ink bottle along the slot in front of the filling port, then slowly stand the bottle up to insert it.

*Note:* Do not force the bottles into position; they are keyed for each color.
5. Wait for the ink to fill the tank. Do not squeeze the bottle. Ink flows into the tank and stops automatically when the ink is filled to the upper line.

Note: If ink does not flow from the bottle, lift and reinsert the bottle.
6. When the ink tank is full, remove the ink bottle and securely close the ink tank cap as shown.

Note: If any ink remains in the bottle, replace the bottle cap and tighten it. Store the bottle upright for later use.

7. Repeat the previous steps as necessary for each ink tank you need to fill.
8. Close the ink tank cover.

Parent topic: Refilling Ink
Related concepts
Purchase Epson Ink
Related references
Ink Safety Precautions
Adjusting Print Quality

If your print quality declines, you may need to run a utility to clean or align the print head.
If running these utilities does not solve the problem, you may need to run a Power Cleaning or clean the paper path.

Print Head Maintenance
Print Head Alignment
Cleaning the Paper Path
Checking the Number of Sheets

Print Head Maintenance

If your printouts become too light, or you see dark or light bands across them, you may need to clean the print head nozzles. Cleaning uses ink, so clean the nozzles only if print quality declines.
You can check for clogged nozzles before you clean them so you don’t clean them unnecessarily.

Note: You may not be able to clean the print head when the ink level in any of the tanks is low. You may have to refill the ink tank first.

If you still see white or dark lines or gaps in your printouts, even after cleaning the print head several times, you can run a Power Cleaning.

Print Head Nozzle Check
Print Head Cleaning
Power Cleaning

Parent topic: Adjusting Print Quality
Related tasks
Refilling the Ink Tanks

Print Head Nozzle Check

You can print a nozzle check pattern to check for clogged nozzles.

Checking the Nozzles Using the Product Buttons
Checking the Nozzles Using a Computer Utility

Parent topic: Print Head Maintenance
Checking the Nozzles Using the Product Buttons

You can check the print head nozzles using the buttons on your product.

1. Press the power button to turn the product off.
2. Load a few sheets of plain paper in the product.
3. Hold down the stop button and press the power button to turn the product on.
4. When the product turns on, release both buttons.
   The product begins printing a nozzle check pattern.

   **Note:** It can take a few seconds for the nozzle check pattern to start printing. If it does not start printing after a few seconds, make sure there is paper loaded in the product.

5. Check the printed pattern to see if there are gaps in the lines.

   **Print head is clean**

   ![Print head is clean]

   **Print head needs cleaning**

   ![Print head needs cleaning]

6. If there are no gaps, the print head is clean and you can continue printing.
   If there are gaps or the pattern is faint, clean the print head.
Parent topic: Print Head Nozzle Check
Related tasks
Loading Paper in the Sheet Feeder
Cleaning the Print Head Using the Product Buttons

Checking the Nozzles Using a Computer Utility

You can check the print head nozzles using a utility on your Windows or Mac computer.

1. Load a few sheets of plain paper in the product.
2. Do one of the following:
   - **Windows**: Access the Windows Desktop and right-click the 📢 icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click 📢.
   - **Mac**: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select Utility and select Open Printer Utility.
3. Select Nozzle Check.
You see a window like this:

4. Click **Print**.
5. Check the printed pattern to see if there are gaps in the lines.

   **Print head is clean**

   ![Print head is clean pattern]

   **Print head needs cleaning**

   ![Print head needs cleaning pattern]

6. If there are no gaps, click **Finish**.
   If there are gaps or the pattern is faint, clean the print head.

**Parent topic:** Print Head Nozzle Check

**Related tasks**
- Loading Paper in the Sheet Feeder
- Cleaning the Print Head Using a Computer Utility

**Print Head Cleaning**

If print quality has declined and the nozzle check pattern indicates clogged nozzles, you can clean the print head.

**Note:** You may not be able to clean the print head when the ink level in any of the tanks is low. You may have to refill the ink tank first.
Cleaning the Print Head Using the Product Buttons
You can clean the print head using the buttons on your product.

1. Make sure no product lights are indicating errors.
2. Load a few sheets of plain paper in the product.
3. Hold down the stop button for five seconds to start the cleaning cycle.
   The power light flashes throughout the cleaning cycle and stays on when the cleaning cycle is finished.

   Caution: Never turn off the product during a cleaning cycle or you may damage it.

4. Run a nozzle check to confirm that the print head is clean.

   If you don’t see any improvement after cleaning the print head up to 3 times, turn off the product and wait at least 12 hours. Then try cleaning the print head again. If quality still does not improve, run a Power Cleaning. If there is still no improvement, contact Epson support.

Cleaning the Print Head Using a Computer Utility
You can clean the print head using a utility on your Windows or Mac computer.

1. Make sure no product lights are indicating errors.
2. Load a few sheets of plain paper in the product.
3. Do one of the following:
   • **Windows**: Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click.
   • **Mac**: In the Apple menu or the Dock, select **System Preferences**. Select **Print & Fax**, **Print & Scan**, or **Printers & Scanners**, select your product, and select **Options & Supplies**. Select **Utility** and select **Open Printer Utility**.

4. Select **Head Cleaning**.
   You see a window like this:

   ![Head Cleaning window](image)

5. Click **Start** to begin the cleaning cycle.
   
   **Caution**: Never turn off the product during a cleaning cycle or you may damage it.
6. When the cleaning cycle is finished, you can check to see if the nozzles are clean; click **Print Nozzle Check Pattern** and click **Print**.

7. Check the printed pattern to see if there are gaps in the lines.

   **Print head is clean**

   ![Print head is clean image]

   **Print head needs cleaning**

   ![Print head needs cleaning image]

   - If there are no gaps, click **Finish**.
   - If there are gaps or the pattern is faint, click **Clean** to clean the print head again.

If you don’t see any improvement after cleaning the print head up to 3 times, turn off the product and wait at least 12 hours. Then try cleaning the print head again. If quality still does not improve, run a Power Cleaning. If there is still no improvement, contact Epson support.

**Parent topic:** Print Head Cleaning

**Related concepts**

Power Cleaning

**Related references**

Where to Get Help
Related tasks
Loading Paper in the Sheet Feeder
Checking the Nozzles Using a Computer Utility

Power Cleaning
If you still see white or dark lines or missing nozzles in your printouts, even after cleaning the print head several times, you can run a Power Cleaning.

If you do not see improvement after running a Power Cleaning, turn off the product and wait at least 12 hours before running another Power Cleaning.

Caution: Running a Power Cleaning consumes a lot of ink, so you should run it only if necessary. Make sure each ink tank is at least one-third full before running a Power Cleaning, or it may damage the product.

Caution: Power Cleaning may cause the ink pads to reach their capacity sooner. When an ink pad reaches the end of its service life, the product stops printing and you must contact Epson for support.

Power Cleaning Using a Computer Utility
Parent topic: Print Head Maintenance
Related tasks
Refilling the Ink Tanks

Power Cleaning Using a Computer Utility
You can run a Power Cleaning using a utility on your Windows or Mac computer.

Note: After running a Power Cleaning, you must turn off the product and wait at least 12 hours before running another Power Cleaning.

1. Make sure no product lights are indicating errors.
2. Load a few sheets of plain paper in the product.
3. Do one of the following:
   - **Windows**: Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click . Select Printer Settings and click the Maintenance tab.
• **Mac:** In the Apple menu or the Dock, select **System Preferences**. Select **Print & Fax, Print & Scan**, or **Printers & Scanners**, select your product, and select **Options & Supplies**. Select **Utility** and select **Open Printer Utility**.

4. Select **Power Cleaning**.
   You see a window like this:
   ![Power Cleaning window](image)

5. Follow the on-screen instructions to run a Power Cleaning.

6. When Power Cleaning is finished, run a nozzle check.
   If print quality has not improved after running Power Cleaning, wait for at least 12 hours without printing, and then print the nozzle check pattern again. Run Print Head Cleaning or Power Cleaning again depending on the printed pattern. If quality still does not improve, contact Epson support.

**Parent topic:** Power Cleaning

**Related concepts**

Print Head Nozzle Check
Print Head Alignment

If your printouts become grainy or blurry, you notice misalignment of vertical lines, or you see dark or light horizontal bands, you may need to align the print head.

Note: Banding may also occur if your print head nozzles need cleaning.

Aligning the Print Head Using a Computer Utility

You can align the print head using a utility on your Windows or Mac computer.

1. Load a few sheets of plain paper in the product.
2. Do one of the following:
   - **Windows**: Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click.
   - **Mac**: In the Apple menu or the Dock, select **System Preferences**, Select **Print & Fax, Print & Scan**, or **Printers & Scanners**, select your product, and select **Options & Supplies.** Select **Utility** and select **Open Printer Utility**.
3. Select **Print Head Alignment**.
4. Click **Next**, then click **Print** to print an alignment sheet.

Note: Do not cancel printing while you are printing a head alignment pattern.
5. Check the printed pattern and follow the instructions on the screen to choose the number of the best printed pattern for each set.

**Vertical alignment**

![Vertical alignment diagram]
Horizontal alignment

1

2

3

• After choosing a pattern number, click **Next**.
• If no patterns are aligned in one or more of the sets, choose the closest one in each set and click **Realignment**. Then print another alignment sheet and check it.

**Note:** Click **Skip** (where available) if you want to skip a particular alignment sheet.

6. When you are done, click **Finish**.

**Parent topic:** Print Head Alignment

**Related tasks**

Loading Paper in the Sheet Feeder

---

**Cleaning the Paper Path**

If you see ink on the back of a printout, you can clean the paper path to remove any excess ink.

**Caution:** Do not use tissues to clean the rollers inside the product; lint from tissue may clog the print head nozzles.

1. Load a few sheets of plain paper in the product.
2. Use the product control panel to make a copy, but without placing a document on the scanner glass.

**Note:** Make sure there is no dust or stains on the scanner glass or document cover.

3. Check the back of the ejected paper to see if it is clean.
4. Repeat as necessary until the paper comes out clean.
Checking the Number of Sheets

You can view an option that displays the number of sheets of paper that have fed through the product.

**Note:** You can also view the number of sheets of paper fed through the product by printing a nozzle check.

Checking the Sheet Counter - Windows
Checking the Sheet Counter - Mac

Parent topic: Adjusting Print Quality

Checking the Sheet Counter - Windows

You can check the number of sheets of paper that have fed through the product by checking the sheet counter.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click.
2. Select **Printer Settings**.
3. Click the **Maintenance** tab.
4. Select **Printer and Option Information**.
You see this window:

![Window displaying printer and option information](image)

5. After checking the number of sheets fed into the printer, click **OK** to close the window.

   **Note:** The number of sheets is displayed only when Epson Status Monitor 3 is enabled.

**Parent topic:** Checking the Number of Sheets

**Checking the Sheet Counter - Mac**

You can check the number of sheets of paper that have fed through the product by checking the sheet counter.

1. In the Apple menu or the Dock, select **System Preferences.** Select **Print & Fax, Print & Scan, or Printers & Scanners**, select your product, and select **Options & Supplies.** Select **Utility** and select **Open Printer Utility.**

2. Select **Printer and Option Information.**
You see this window:

3. After checking the number of sheets fed into the printer, click **OK** to close the window.

**Parent topic:** Checking the Number of Sheets
Cleaning and Transporting Your Product

See these sections if you need to clean or transport your product.

Cleaning Your Product
Transporting Your Product

Cleaning Your Product

To keep your product working at its best, you should clean it several times a year.
Close the output tray and paper support when you are not using the product to protect it from dust.

Caution: Do not use a hard brush, alcohol, or paint thinner to clean the product or you may damage it.
Do not use oil or other lubricants inside the product or let water get inside it.

1. Turn off the product.
2. Unplug the power cable.
3. Disconnect any connected cables.
4. Remove all the paper.
5. Clean the scanner glass with a soft, lint-free cloth (microfiber is recommended), moistened with a little glass cleaner.

Caution: Do not spray glass cleaner directly on the glass and do not press the glass surface with any force.

6. Clean the outer case and control panel with a soft, dry cloth. Do not use liquid or chemical cleansers.

Parent topic: Cleaning and Transporting Your Product

Transporting Your Product

If you need to store your product or transport it some distance, prepare it for transportation as described here.
Caution: During transportation and storage, follow these guidelines:

- Avoid tilting the product, placing it vertically, or turning it upside down; otherwise ink may leak.

- When storing or transporting an ink bottle after removing its seal, do not tilt the bottle and do not subject it to impacts or temperature changes. Otherwise, ink may leak even if the cap on the ink bottle is tightened securely. Be sure to keep the ink bottle upright when tightening the cap, and take measures to prevent ink from leaking when transporting the ink bottles.

- Do not put opened ink bottles in the box with the product.

Note: Before storing your product for a long period, replace low, expended, or expired ink to help prevent the print head from drying out. Store your product in a cool, dry place.

1. Turn off the product.
2. Open the front cover and check to see if the print head is in the far right position (the home position). If not, turn on the product, wait for the print head to move to the far right, then turn the product off again.
3. Unplug the power cable.
4. Disconnect any connected cables.
5. Remove all the paper.
6. Open the ink tank cover and make sure that the ink tank caps are securely closed as shown.

7. Close the ink tank cover.
8. Close the paper support, feeder guard, and output tray.

9. Place the product in its original packaging materials, if possible, or use equivalent cushioning around the product.

If print quality has declined when you print again, clean and align the print head.

**Parent topic:** Cleaning and Transporting Your Product

**Related concepts**
- Print Head Cleaning
- Print Head Alignment
Solving Problems

Check these sections for solutions to problems you may have using your product.

Checking for Software Updates
Product Light Status
Running a Product Check
Solving Setup Problems
Solving Copying Problems
Solving Paper Problems
Solving Problems Printing from a Computer
Solving Page Layout and Content Problems
Solving Print Quality Problems
Solving Scanning Problems
Solving Scanned Image Quality Problems
Uninstall Your Product Software
Where to Get Help

Checking for Software Updates

It's a good idea to check Epson's support website occasionally for free updates to your product software. Visit epson.com.jm/support and select your product.

• **Windows**: Your printer software automatically checks for updates. You can also manually update the software by selecting **Software Update** here:
  
  • Accessing the Windows Desktop and right-clicking the icon for your product in the right side of the Windows taskbar, or clicking the up arrow and right-clicking.
  
  • On the **Maintenance** tab in the printer settings window

You can also update the software by selecting **EPSON Software Updater** in the **EPSON** or **Epson Software** program group, accessible by the **Start** button, or on the **Start** or **Apps** screens, depending on your version of Windows.

• **OS X**: You can manually update the software by opening the **Applications** > **Epson Software** folder and selecting **EPSON Software Updater**.

• **macOS 10.12.x or 10.13.x**: You can manually update the software by opening the **App Store**, selecting **Updates**, searching for a software update option for Epson Software, and selecting **Update**.
Parent topic: Solving Problems
Related tasks
Changing Automatic Update Options

Product Light Status

You can often diagnose problems with your product by checking its lights.

1  power light
2  ink light
3  paper light

<table>
<thead>
<tr>
<th>Light status</th>
<th>Condition/solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The power light is on</td>
<td>The product is turned on.</td>
</tr>
<tr>
<td>The power light is flashing</td>
<td>The product is busy. Wait for the power light to stop flashing before turning off the product.</td>
</tr>
<tr>
<td>The ink light is on</td>
<td>Initial ink charging may not be complete. See the Start Here sheet for instructions.</td>
</tr>
<tr>
<td>The paper light is on</td>
<td>No paper is loaded or multiple sheets fed at one time. Load paper in the product, and press the B&amp;W copy button or the color copy button to clear the error.</td>
</tr>
<tr>
<td>Light status</td>
<td>Condition/solution</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>The ⚠️ paper light is flashing</td>
<td>Paper is jammed in the product. Remove the jammed paper, and press the ⬇️ B&amp;W copy button or the ⬆️ color copy button to clear the error.</td>
</tr>
<tr>
<td>The ⚪️ power and ⚠️ paper lights are flashing simultaneously</td>
<td>An ink pad is nearing or at the end of its service life. Contact Epson for support. If a message to continue printing appears on your computer, press the ⬇️ B&amp;W copy button or the ⬆️ color copy button to continue printing.</td>
</tr>
<tr>
<td>The ⚪️ power and ⚠️ paper lights are flashing alternately</td>
<td>A borderless printing ink pad is nearing or at the end of its service life. Contact Epson for support. If a message to continue printing appears on your computer, press the ⬇️ B&amp;W copy button or the ⬆️ color copy button to continue printing. Borderless printing is not available until the ink pad is replaced.</td>
</tr>
<tr>
<td>All lights are flashing</td>
<td>Paper or protective material is stuck inside the product. Open the front cover and remove any jammed paper or protective materials. Turn the product off and then back on again. If the error continues, contact Epson for support.</td>
</tr>
<tr>
<td>The ⚪️ power light is off</td>
<td>An error has occurred during firmware updating. Try updating the firmware again. If the error continues, contact Epson for support.</td>
</tr>
<tr>
<td>The 🔵 ink light is on</td>
<td></td>
</tr>
<tr>
<td>The ⚠️ paper light is on</td>
<td></td>
</tr>
<tr>
<td>The ⚪️ power light is on or flashing</td>
<td>The product was not turned off correctly. Press the ⬇️ B&amp;W copy button or the ⬆️ color copy button to clear the error, then perform a nozzle check and cancel any pending print jobs. Use the ⚪️ power button to turn the product off.</td>
</tr>
</tbody>
</table>

**Note:** The ink pads in the printer collect, distribute, and contain the ink that is not used on printed pages. During the life of your product it may reach a condition where either satisfactory print quality cannot be maintained or the ink pads have reached the end of their usable life. The Epson Status Monitor, your LCD screen, or lights on the control panel will advise you when these parts need replacing. If this happens during the standard warranty of the product, the exchange of the product or replacement of the pads is covered under the standard warranty. If the product is out of warranty, the pads can be replaced by any Epson authorized service provider. The waste ink pads are not a user-replaceable part.

**Parent topic:** Solving Problems
Running a Product Check

Running a product check helps you determine if your product is operating properly.

1. Press the ♦️ power button to turn the product off.
2. Load a few sheets of plain paper in the product.
3. Hold down the ⏿️ stop button and press the ♦️ power button to turn the product on.
4. When the product turns on, release both buttons.
   The product begins printing a nozzle check pattern.

   **Note:** It can take a few seconds for the nozzle check to start printing. If the nozzle check does not start printing after a few seconds, make sure there is paper loaded in the printer.
5. Check the printed pattern to see if there are gaps in the lines.

   **Print head is clean**

   ![Print head is clean pattern](image)

   **Print head needs cleaning**

   ![Print head needs cleaning pattern](image)

6. Do one of the following, depending on the results of the product check:

   - If the page prints and the nozzle check pattern is complete, the product is operating properly. Any operation problem you may have could be caused by your computer, cable, software, or selected settings. Check the other solutions in this book or try uninstalling and reinstalling your printer software.

   - If the page prints but the nozzle check pattern has gaps, clean or align the print head.

   - If the page does not print, the product may have a problem. Check the other solutions in this manual. If they do not work, contact Epson.

**Parent topic:** Solving Problems

**Related concepts**

- Print Head Cleaning
- Print Head Alignment
- Uninstall Your Product Software
Solving Setup Problems

Check these sections if you have problems while setting up your product.

Noise After Filling the Ink

If you hear noises from your product after filling the ink tanks with ink, check these explanations:

• The first time you fill the tanks with ink, the product must charge its print head. Wait until charging
  finishes before you turn off the product, or it may charge improperly and use excess ink the next time
  you turn it on. Your product is finished charging the print head when the power light stops flashing.

• If the product's print head stops moving or making noise, and the charging process has not finished
  after approximately 20 minutes, turn off your product. Turn it back on and check to see if charging is
  still in progress. If it is still in progress, contact Epson for help.

Parent topic: Solving Setup Problems

Related tasks
Refilling the Ink Tanks

Software Installation Problems

If you have problems while installing your product software, try these solutions:

• Make sure your product is turned on and any necessary cables are securely connected at both ends. If
  you still have problems installing software, disconnect the cable and carefully follow the instructions on
  the Start Here sheet. Also make sure your system meets the requirements for your operating system.

• Close any other programs, including screen savers and virus protection software, and install your
  product software again.

• In Windows, make sure your product is selected as the default printer and the correct port is shown in
  the printer properties.

• If you see any error message or your software does not install correctly in Windows, you may not have
  software installation privileges. Contact your system administrator.

Parent topic: Solving Setup Problems
Solving Copying Problems

Check these solutions if you have problems copying with your product.

Product Makes Noise, But Nothing Copies
Product Makes Noise When It Sits for a While

Parent topic: Solving Problems

Product Makes Noise, But Nothing Copies

If your product makes a noise, but nothing copies, try these solutions:

- Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
- If the nozzle check page does not print, but the product's power is on, make sure your product software is installed correctly.
- Make sure your product is level (not tilted).

Parent topic: Solving Copying Problems

Related concepts
Print Head Nozzle Check
Print Head Cleaning

Product Makes Noise When It Sits for a While

Your product is performing routine maintenance. This is normal.

Parent topic: Solving Copying Problems

Solving Paper Problems

Check these sections if you have problems using paper with your product.

Paper Feeding Problems
Paper Jam Problems
Paper Ejection Problems

Parent topic: Solving Problems

Paper Feeding Problems

If you have problems feeding paper, try these solutions:

• Place the product on a flat surface.

• If paper does not feed for printing, remove it. Then reload it in the middle of the rear paper feed. Slide the edge guide against the edge of the paper, making sure that the paper stack is not above the arrow mark on the edge guide.

• If multiple pages feed at once, remove the paper, fan the edges to separate the sheets, and reload it.

• If paper jams when you load only one or two sheets, try loading more sheets at a time. Do not load more than the recommended number of sheets.

• If paper jams when you print on both sides of the paper, try loading fewer sheets.

• Make sure your paper meets the specifications for your product.

• For best results, follow these guidelines:
  • Use new, smooth, high-quality paper that is not curled, creased, old, too thin, or too thick.
  • Load paper in the rear paper feed printable side up.
  • Follow any special loading instructions that came with the paper.

Parent topic: Solving Paper Problems

Related references
Paper Loading Capacity
Paper Jam Problems

Related tasks
Loading Paper in the Sheet Feeder

Paper Jam Problems

If you have problems with paper jams, try these solutions:

1. Cancel the print job from your computer, if necessary.
2. Gently pull out any jammed paper from the rear paper feed slot.

3. Open the front cover.
4. Gently remove any jammed paper.

Caution: Do not touch the parts shown here or you may damage the product.
5. Close the front cover.

6. Carefully follow all paper loading instructions when you load new paper.

Parent topic: Solving Paper Problems

Related tasks
Loading Paper in the Sheet Feeder
Cancelling Printing Using a Product Button

Paper Ejection Problems

If you have problems with paper ejecting properly, try these solutions:

- If paper does not eject fully, you may have set the wrong paper size. Cancel printing to eject the paper. Select the correct paper size when you reprint.
- If paper is wrinkled when it ejects, it may be damp or too thin. Load new paper and be sure to select the correct paper type setting when you reprint.

Parent topic: Solving Paper Problems

Related references
Paper or Media Type Settings - Printing Software

Related tasks
Loading Paper in the Sheet Feeder
Cancelling Printing Using a Product Button
Solving Problems Printing from a Computer

Check these sections if you have problems while printing from your computer.

Nothing Prints  
Product Icon Does Not Appear in Windows Taskbar  
Printing is Slow

Parent topic: Solving Problems

Nothing Prints

If you have sent a print job and nothing prints, try these solutions:

- Make sure your product is turned on and connected to your computer.
- Make sure any interface cables are connected securely at both ends.
- If you connected your product to a USB hub, make sure it is a first-tier hub. If it still does not print, connect your product directly to your computer instead of the hub.
- Make sure the printer status is not offline or pending.
- Run a product check to see if a test page prints. If the test page prints, check to see if your product software is installed correctly.
- Make sure your system meets the requirements for your operating system. If you are printing a high-resolution image, you may need more than the minimum requirements. Print the image at a lower resolution or if necessary, increase your system's memory.
- In Windows, make sure your product is selected as the default printer and the printer port setting matches the printer connection port.
- In Windows, delete all jobs from the Windows Spooler. Click Print Queue on the Maintenance tab in the printer settings window, and cancel any stalled print jobs.
- On a Mac, make sure the printer is added to the printer list and the printer is not paused.
- Make sure your product is selected as the printer in your printing program.

Parent topic: Solving Problems Printing from a Computer

Related tasks
Running a Product Check
Product Icon Does Not Appear in Windows Taskbar

If you do not see your product icon in the Windows taskbar, first try restarting your computer. If that does not work, try this solution:

1. Do one of the following:
   • **Windows 10**: Click and select (Settings) > Devices > Printers & scanners. Select your product name and select Manage > Printing preferences.
   • **Windows 8.x**: Navigate to the Apps screen and select Control Panel > Hardware and Sound > Devices and Printers. Right-click your product name, select Printing Preferences, and select your product name again if necessary.
   • **Windows 7**: Click and select Devices and Printers. Right-click your product name, select Printing Preferences, and select your product name again if necessary.
   • **Windows Vista**: Click , select Control Panel, and click Printer under Hardware and Sound. Right-click your product name, select Printing Preferences, and select your product name again if necessary.

2. Click the Maintenance tab.
3. Click the Extended Settings button.
4. Select Enable EPSON Status Monitor 3 and click OK.
5. Click the Monitoring Preferences button.
6. Click the checkbox for the option that adds the shortcut icon to the taskbar.
7. Click OK to close the open program windows.

**Parent topic:** Solving Problems Printing from a Computer

Printing is Slow

If printing becomes slow, try these solutions:

- Make sure your system meets the requirements for your operating system. If you are printing a high-resolution image, you may need more than the minimum requirements. If necessary, increase your system's memory.
- If you are using Windows 7, close the Devices and Printers window before you print.
- On a Mac, make sure you download and install the Epson printer driver.
- Make sure Quiet Mode is turned off.
• Clear space on your hard drive or run a defragmentation utility to free up existing space.
• Close any programs you are not using when you print.
• If your product is connected to a USB hub, connect it directly to your computer instead.
• If printing becomes slower after printing continuously for a long time, the product may have automatically slowed down to protect the print mechanism from overheating or becoming damaged. Let the product rest with the power on for 30 minutes, then try printing again.

For the fastest printing, select the following settings in your product software:
• Make sure the paper type setting matches the type of paper you loaded.
• Turn on any high speed settings in your product software.
• Select a lower print quality setting.
• **Windows**: Click the **Maintenance** or **Utility** tab, select **Extended Settings** or **Speed and Progress**, and select the following settings:
  • **Always Spool RAW Datatype**
  • **Page Rendering Mode**
  • **Print as Bitmap**
• **Windows**: Select **Printer Properties**, click the **More Options** tab, and make sure the **High Speed** setting is enabled.
• **Mac**: Select **System Preferences**, select **Printers & Scanners**, and select your product. Select **Options & Supplies**, select **Options** (or **Driver**), and enable the **High Speed Printing** setting.

If printing is still slow and you are using Windows 7 or Windows Vista, try the following:

1. Click and select **Computer** or **My Computer**. Double-click the C:\ drive and open these folders: **ProgramData > EPSON > PRINTER**.

   **Note**: If you do not see the ProgramData folder, open the **Organize** menu and select **Folder and search options**. In the window that appears, click the **View** tab, select **Show hidden files, folders, and drives** in the Advanced settings list, and click **OK**.

2. Right-click the **EPAUDF01.AUD** file and select **Delete**.

3. Restart your computer and try printing again.

**Parent topic**: Solving Problems Printing from a Computer
Solving Page Layout and Content Problems

Check these sections if you have problems with the layout or content of your printed pages.

Inverted Image
Too Many Copies Print
Blank Pages Print
Incorrect Margins on Printout
Border Appears on Borderless Prints
Incorrect Characters Print
Incorrect Image Size or Position
Slanted Printout

Parent topic: Solving Problems

Inverted Image

If your printed image is inverted unexpectedly, try these solutions:

• Turn off any mirror or inversion settings in your printing application.
• Turn off the Mirror Image, Flip horizontally, or Reverse page orientation settings in your printer software. (This option has different names, depending on your operating system version.)

Parent topic: Solving Page Layout and Content Problems

Related tasks
Selecting Additional Layout and Print Options - Windows
Selecting Print Layout Options - Mac
Too Many Copies Print

Make sure that the **Copies** setting in your printing program or printer software is not set for multiple copies.

*Parent topic*: Solving Page Layout and Content Problems

Blank Pages Print

If blank pages print unexpectedly, try these solutions:

- Make sure you selected the correct paper size settings in your printing program and printer software.
- If a blank page exists in a document you are printing and you want to skip printing it, select the **Skip Blank Page** setting in your printer software, if available.
- Run a print head nozzle check to see if any of the nozzles are clogged. Then clean the print head, if necessary.
- Make sure your product is selected as the printer in your printing program.
- You may need to refill the ink. Visually check the ink levels.

*Parent topic*: Solving Page Layout and Content Problems

**Related concepts**

Print Head Nozzle Check
Print Head Cleaning

**Related references**

Paper or Media Type Settings - Printing Software

**Related tasks**

Checking Ink Levels on Your Product
Selecting Basic Print Settings - Windows
Selecting Extended Settings - Windows
Selecting Basic Print Settings - Mac
Selecting Printing Preferences - Mac

Incorrect Margins on Printout

If your printed page has incorrect margins, try these solutions:

- Make sure you selected the correct paper size settings in your printing program and printer software.
- Make sure you selected the correct margins for your paper size in your printing program.
• Make sure your paper is positioned correctly for feeding into the product.
• When placing originals on the scanner glass, align the corner of the original with the corner indicated by the arrow. If the edges of the copy are cropped, move the original slightly away from the corner.
• Clean the scanner glass and the document cover. If there is dust or stains on the glass, the copy area may extend to include the dust or stains.

You can use the preview option in your printer software to check your margins before you print.

Parent topic: Solving Page Layout and Content Problems
Related references
Paper or Media Type Settings - Printing Software
Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Related topics
Loading Paper

Border Appears on Borderless Prints
If you see a border on borderless prints, try these solutions:
• Make sure you are printing on a compatible borderless paper type and size.
• **Windows**: Make sure you selected the **Borderless** setting in your printer software.
• **Mac**: Make sure you selected the **Borderless** checkbox or a paper size with a **Borderless** option in your printer software.
• Adjust the **Expansion** setting to adjust the amount of image expansion on the edges of borderless prints.
• Make sure the image size and the paper size are set correctly; if the image is small, the enlargement may not be enough to cover the paper.
• Access the Extended Settings (Windows) or Printing Preferences (Mac) and select **Remove White Borders**.

Parent topic: Solving Page Layout and Content Problems
Related references
Paper or Media Type Settings - Printing Software
Print Options - Mac
Incorrect Characters Print

If incorrect characters appear in your prints, try these solutions before reprinting:

- Make sure any cables are securely connected at both ends.
- In Windows, delete all jobs from the Windows Spooler. Click Print Queue on the Maintenance tab in the printer settings window, and cancel any stalled print jobs.
- If your product is connected to a USB hub, connect it directly to your computer instead.
- If incorrect characters still appear in your prints, try connecting your product using a different cable.
- If your computer entered sleep mode the last time you printed, the next print job after your computer exits sleep mode may contain garbled characters. Print your document again.
- Make sure you are using the printer software for this product. Check the product name at the top of the driver window.

Incorrect Image Size or Position

If your printed image is the wrong size or in the wrong position, try these solutions:

- Make sure you selected the correct paper size and layout settings in your printing program and printer software.
- Make sure your paper is positioned correctly for feeding into the printer.
- Clean the scanner glass and document cover.
- If the edges of a copy are cropped, slightly move the original away from the edges of the scanner glass.
- Make sure you selected the correct margins for your paper size in your printing program.

You can use the preview option in your printer software to check your margins before you print.
Slanted Printout

If your printouts are slanted, try these solutions:

• Slide the edge guides against the edges of the paper.
• Select a higher print quality setting in your printer software.
• Turn off any high speed settings in your product software.
• Align the print head.
• Make sure the product is not printing while tilted or at an angle.

Parent topic: Solving Page Layout and Content Problems
Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Placing Originals on the Scanner Glass
Related topics
Loading Paper

Solving Print Quality Problems

Check these sections if your printouts have problems with print quality, but your image looks fine on your computer screen.

White or Dark Lines in Printout
Blurry or Smeared Printout
Faint Printout or Printout Has Gaps
Grainy Printout
Incorrect Colors

Parent topic: Solving Problems

White or Dark Lines in Printout

If you notice white or dark lines in your prints (also called banding), try these solutions before you reprint:

- Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
- Make sure the paper type setting matches the type of paper you loaded.
- Make sure you loaded the printable side of the paper correctly for your product.
- Turn off any high speed settings in your product software.
- Align the print head.
- Adjust the print quality in the product software.
- You may need to refill the ink. Visually check the ink levels.
- If you have not used the product for a long time, run the Power Cleaning utility.

Note: Power Cleaning consumes a lot of ink, so run this utility only if you cannot improve print quality by cleaning the print head.

Parent topic: Solving Print Quality Problems

Related concepts

Print Head Nozzle Check
Print Head Cleaning
Print Head Alignment
Power Cleaning

Related references

Paper or Media Type Settings - Printing Software

Related tasks

Checking Ink Levels on Your Product
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Refilling the Ink Tanks
Blurry or Smeared Printout

If your printouts are blurry or smeared, try these solutions:

• Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
• Use a support sheet with special paper, or load special paper one sheet at a time.
• Make sure your paper meets the specifications for your product.
• Use Epson papers to ensure proper saturation and absorption of genuine Epson inks.
• Make sure the paper type setting in your product software matches the type of paper you loaded.
• Make sure you loaded the printable side of the paper correctly for your product.
• Remove each sheet from the output tray as it is printed.
• Avoid handling printouts on glossy paper right after printing to allow the ink to set.
• Turn off any high speed settings in your product software.

If you print on both sides of a sheet of paper, smudges may appear on the reverse side of heavily saturated or dark images. If one side of a sheet will contain a lighter image or text, print that side first. Make sure the ink has dried before reloading the paper to print on the other side. Adjust the density and/or ink drying time settings.

• The ink levels may be low and you may need to refill the ink. Visually check the ink levels.
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
• Align the print head.
• Adjust the print quality in the product software.
• Clean the paper path.

If you printed when the ink levels were too low to be seen in the ink tank windows, refill the ink tanks to the upper lines and run the Power Cleaning utility. Then run a nozzle check to see if print quality has improved.

• If you have not used the product for a long time, run the Power Cleaning utility.

Note: Power Cleaning consumes a lot of ink, so run this utility only if you cannot improve print quality by cleaning the print head.
**Note:** Your product will not operate properly while tilted at an angle. Place it on a flat, stable surface that extends beyond the base of the product in all directions.

**Parent topic:** Solving Print Quality Problems

**Related concepts**
- Print Head Nozzle Check
- Print Head Cleaning
- Print Head Alignment
- Power Cleaning

**Related references**
- Paper or Media Type Settings - Printing Software
- Compatible Epson Papers

**Related tasks**
- Checking Ink Levels on Your Product
- Selecting Basic Print Settings - Windows
- Selecting Basic Print Settings - Mac
- Cleaning the Paper Path
- Refilling the Ink Tanks

**Related topics**
- Loading Paper

**Faint Printout or Printout Has Gaps**

If your printouts are faint or have gaps, try these solutions:

- Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
- The ink levels may be low. Visually check the ink levels.
- Make sure the paper type setting matches the type of paper you loaded.
- Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
- Align the print head.
- Adjust the print quality in the product software.
- Clean the paper path.
- If you have not used the product for a long time, run the Power Cleaning utility.
Note: Power Cleaning consumes a lot of ink, so run this utility only if you cannot improve print quality by cleaning the print head.

Parent topic: Solving Print Quality Problems

Related concepts
Print Head Nozzle Check
Print Head Cleaning
Print Head Alignment

Related references
Paper or Media Type Settings - Printing Software

Related tasks
Checking Ink Levels on Your Product
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Cleaning the Paper Path
Refilling the Ink Tanks

Related topics
Loading Paper

Grainy Printout
If your printouts are grainy, try these solutions:

- Make sure you loaded the printable side of the paper correctly for your product.
- Select a higher print quality setting and turn off any high speed settings in your product software.
- Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
- Align the print head.
- Adjust the print quality in the product software.
- You may need to increase the image resolution or print a smaller size; see your software documentation.

Note: Images from the Internet may be low resolution and not result in a high quality printout.
If you enlarged the image size in an image-editing program, you need to increase the image resolution setting to retain a high image quality. Increase the image resolution by the same amount you increase the image size. For example, if the image resolution is 300 dpi (dots per inch) and you will double the image size for printing, change the resolution setting to 600 dpi.

**Note:** Higher resolution settings result in larger file sizes, which take longer to process and print. Consider the limitations of your computer system when selecting a resolution, and select the lowest possible resolution that produces acceptable quality to keep file sizes manageable.

**Incorrect Colors**

If your printouts have incorrect colors, try these solutions:

- Make sure the paper type setting matches the paper you loaded.
- Make sure the **Black/Grayscale** or **Grayscale** setting is not selected in your printer software.
- If you selected **Standard-Vivid** (Windows) or **Normal-Vivid** (Mac) as the quality setting in the printer software, try selecting **Standard** (Windows) or **Normal** (Mac) instead.
- Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
- The ink levels may be low and you may need to refill the ink. Visually check the ink levels.
- After you print, the colors in your printout need time to set as the ink dries. During this time, the colors may look different than you expect. To speed up drying time, do not stack your printouts on top of each other.
• Your printed colors can never exactly match your on-screen colors. However, you can use a color management system to get as close as possible. Try using the color management options in your printer software.

• For best results, use genuine Epson paper.

• If you have not used the product for a long time, run the Power Cleaning utility.

  **Note:** Power Cleaning consumes a lot of ink, so run this utility only if you cannot improve print quality by cleaning the print head.

**Parent topic:** Solving Print Quality Problems

**Related concepts**

Print Head Nozzle Check
Print Head Cleaning
Power Cleaning

**Related references**

Paper or Media Type Settings - Printing Software
Compatible Epson Papers

**Related tasks**

Checking Ink Levels on Your Product
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Refilling the Ink Tanks

## Solving Scanning Problems

Check these solutions if you have problems scanning with your product.

**Scanning Software Does Not Operate Correctly**

If your scanning software does not operate correctly, try these solutions:

• Make sure your computer has adequate memory and meets the system requirements for your operating system.
• Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so, wake your system and restart your scanning software.
• If you upgraded your operating system but did not reinstall your scanning software, try reinstalling it.
• In Windows, make sure your product is listed as a valid device in the Scanners and Cameras control panel.

Parent topic: Solving Scanning Problems
Related concepts
Uninstall Your Product Software
Related references
Windows System Requirements
Mac System Requirements

Cannot Start Epson Scan 2
If you cannot start Epson Scan 2, try these solutions:
• Make sure your product is turned on and any interface cables are securely connected at both ends.
• Make sure Epson Scan 2 is selected as your scanning program.
• Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so, wake your system and restart Epson Scan 2.
• Check the connection setting and test the connection using Epson Scan 2 Utility:
  
  Windows 10: Click and select EPSON > Epson Scan 2 Utility. Make sure the correct product is selected. If necessary, select the Other tab and click Reset.
  
  Windows 8.x: Navigate to the Apps screen and select Epson Scan 2 Utility. Make sure the correct product is selected. If necessary, select the Other tab and click Reset.

  Windows (other versions): Click or Start > All Programs or Programs > EPSON > Epson Scan 2 > Epson Scan 2 Utility. Make sure the correct product is selected. If necessary, select the Other tab and click Reset.

  Mac: Open the Applications folder, click Epson Software, and click Epson Scan 2 Utility. Make sure the correct product is selected. If necessary, select the Other tab and click Reset.
• Make sure you do not have multiple versions of Epson Scan 2 installed. If you do, uninstall both versions and install one version.
• If you upgraded your operating system but did not reinstall Epson Scan 2, try reinstalling it.
Solving Scanned Image Quality Problems

Check these sections if a scanned image on your computer screen has a quality problem.

- Image Consists of a Few Dots Only
- Line of Dots Appears in All Scanned Images
- Straight Lines in an Image Appear Crooked
- Image is Distorted or Blurry
- Image Colors are Patchy at the Edges
- Image is Too Dark
- Back of Original Image Appears in Scanned Image
- Ripple Patterns Appear in an Image
- Scanned Image Colors Do Not Match Original Colors
- Scanned Image Edges are Cropped

Image Consists of a Few Dots Only

If your scanned image consists only of a few dots, try these solutions:
- Make sure you placed your original for scanning facing the correct way.
- If the Image Type setting is Black & White, adjust the Threshold and scan again.

Parent topic: Solving Scanned Image Quality Problems

Related references
- Additional Scanning Settings - Main Settings Tab

Related tasks
- Placing Originals on the Scanner Glass
Line of Dots Appears in All Scanned Images

If a line of dots appears in all your scanned images, try these solutions:

• Clean the scanner glass with a soft, dry, lint-free cloth or use a small amount of glass cleaner on the cloth, if necessary. Paper towels are not recommended.

  **Caution:** Do not spray glass cleaner directly on the scanner glass.

• Make sure any interface cables are securely connected at both ends.

  **Parent topic:** Solving Scanned Image Quality Problems

  **Related tasks**

  Cleaning Your Product

Straight Lines in an Image Appear Crooked

If straight lines in an original appear crooked in a scanned image, make sure to place your original straight when you scan it.

  **Parent topic:** Solving Scanned Image Quality Problems

  **Related tasks**

  Placing Originals on the Scanner Glass

Image is Distorted or Blurry

If a scanned image appears distorted or blurry, try these solutions:

• Do not move your original or your product during scanning.

• Your product will not operate properly while tilted at an angle. Place your product on a flat, stable surface that extends beyond its base in all directions.

• Adjust these Epson Scan 2 settings (if available) and try scanning again:
  
  • Increase the **Resolution** setting.
  
  • If the **Image Type** setting is **Black & White**, adjust the **Threshold** setting.
  
  • If the **Image Type** setting is **Color** or **Grayscale**, select the **Unsharp Mask** setting.
  
  • If the **Image Type** setting is **Black & White**, select **Text Enhancement**. If the **Image Type** setting is **Color** or **Grayscale**, change the **Text Enhancement** setting to **High**.

  **Parent topic:** Solving Scanned Image Quality Problems
Image Colors are Patchy at the Edges
If you are scanning a thick or warped original, cover its edges with paper to block external light as you scan it.

Parent topic: Solving Scanned Image Quality Problems

Image is Too Dark
If your scanned image is too dark, try these solutions:

• If the Image Type is set to Color or Grayscale, adjust the Brightness setting.
• Check the brightness and contrast settings of your computer monitor.

Parent topic: Solving Scanned Image Quality Problems

Back of Original Image Appears in Scanned Image
If an image from the back of a thin original appears in your scanned image, try these solutions:

• Place a piece of black paper on the back of the original and scan it again.
• Adjust these Epson Scan 2 settings (if available) and try scanning again:
  • Select the Advanced Settings tab and adjust the Brightness setting.
  • Select Text Enhancement.

Parent topic: Solving Scanned Image Quality Problems
Ripple Patterns Appear in an Image

You may see a ripple pattern (called a moiré) in scanned images of printed documents. This is caused by interference from differing pitches in the scanner's screen and your original's halftone screen. To reduce this effect, adjust these Epson Scan 2 settings (if available) and try scanning again:

- Select the **Descreening** setting.
- Select a lower **Resolution** setting.

**Parent topic:** Solving Scanned Image Quality Problems

**Related references**

- Additional Scanning Settings - Main Settings Tab
- Additional Scanning Settings - Advanced Settings Tab

Scanned Image Colors Do Not Match Original Colors

Printed colors can never exactly match the colors on your computer monitor because printers and monitors use different color systems: monitors use RGB (red, green, and blue) and printers typically use CMYK (cyan, magenta, yellow, and black).

Check the color matching and color management capabilities of your computer, display adapter, and the software you are using to see if they are affecting the palette of colors you see on your screen.

To adjust the colors in your scanned image, adjust these Epson Scan 2 settings (if available) and try scanning again:

- If the **Image Type** setting is **Color** or **Grayscale**, adjust the **Contrast** setting.
- If the **Image Type** setting is **Black & White** or **Grayscale**, adjust the **Color Enhance** setting.

**Parent topic:** Solving Scanned Image Quality Problems

**Related references**

- Additional Scanning Settings - Main Settings Tab
- Additional Scanning Settings - Advanced Settings Tab

Scanned Image Edges are Cropped

If the edges of a scanned image are cropped, make sure your original is placed correctly for scanning. If necessary, move your original away from the edges of the scanner glass slightly.

**Parent topic:** Solving Scanned Image Quality Problems

**Related tasks**

- Placing Originals on the Scanner Glass
Uninstall Your Product Software

If you have a problem that requires you to uninstall and re-install your software, follow the instructions for your operating system.

Uninstalling Product Software - Windows
Uninstalling Product Software - Mac

Parent topic: Solving Problems

Uninstalling Product Software - Windows

You can uninstall and then re-install your product software to solve certain problems.

1. Turn off the product.
2. Disconnect any interface cables.
3. Do one of the following:
   - **Windows 10**: Click and select (Settings) > Apps or System > Apps & features. Then select the program you want to uninstall and select Uninstall.
   - **Windows 8.x**: Navigate to the Apps screen and select Control Panel > Programs > Programs and Features. Select the uninstall option for your Epson product, then select Uninstall/Change.
     
     **Note**: If you see a User Account Control window, click Yes or Continue.

     Select your product again, if necessary, then select OK, and click Yes to confirm the uninstallation.

   - **Windows (other versions)**: Click or Start, and select All Programs or Programs. Select EPSON, select your product, then click EPSON Printer Software Uninstall.
     
     **Note**: If you see a User Account Control window, click Yes or Continue.

     In the next window, select your product and click OK. Then follow any on-screen instructions.

4. Do one of the following to uninstall Epson Event Manager, then follow any on-screen instructions:
   - **Windows 10/8.x**: Select Epson Event Manager and click Uninstall.
   - **Windows 7/Windows Vista**: Open the Windows Control Panel utility. Select Programs and Features. (In Classic view, select Programs and click Uninstall a program.) Select Epson Event Manager and click Uninstall/Change.
5. Do one of the following to uninstall Epson Scan 2, then follow any on-screen instructions:
   • **Windows 10**: Select *Epson Scan 2* and click **Uninstall**.
   • **Windows 8.x/Windows 7/Windows Vista**: Select *Epson Scan 2* and click **Uninstall/Change**.

6. Restart your computer, then see the *Start Here* sheet to re-install your software.

   **Note**: If you find that re-installing your product software does not solve a problem, contact Epson.

**Parent topic:** [Uninstall Your Product Software](#)

### Uninstalling Product Software - Mac

In most cases, you do not need to uninstall your product software before re-installing it. However, you can download the Uninstaller utility from the Epson support website to uninstall your product software as described here.

**Note**: If you find that re-installing your product software does not solve a problem, contact Epson.

1. To download the Uninstaller utility, visit epson.com.jm/support and select your product.
2. Click **Downloads**.
3. Select your operating system, click **Utilities**, locate the Uninstaller utility, and click **Download**.
4. Run the file you downloaded.
5. Double-click the **Uninstaller** icon.
6. In the Epson Uninstaller screen, select the checkbox for each software program you want to uninstall.
7. Click **Uninstall**.
8. Follow the on-screen instructions to uninstall the software.
9. Reinstall your product software.

**Note**: If you uninstall the printer driver and your product name remains in the **Print & Fax**, **Print & Scan**, or **Printers & Scanners** window, select your product name and click the – (remove) icon to remove it.

**Parent topic:** [Uninstall Your Product Software](#)
Where to Get Help

If you need additional help with your Epson product, contact Epson.

Epson provides these technical support services:

**Internet Support**
Visit Epson’s support website at epson.com.jm/support for solutions to common problems. You can download drivers and documentation, get FAQs and troubleshooting advice, or e-mail Epson with your questions.

**Speak to a Support Representative**
Before you call Epson for support, please have the following information ready:

- Product name
- Product serial number (located on a label on the product)
- Proof of purchase (such as a store receipt) and date of purchase
- Computer configuration
- Description of the problem

Then call:

<table>
<thead>
<tr>
<th>Country</th>
<th>Telephone</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argentina</td>
<td>(54 11) 5167-0300 0800-288-37766</td>
</tr>
<tr>
<td>Bolivia*</td>
<td>800-100-116</td>
</tr>
<tr>
<td>Brazil</td>
<td>State capitals and metropolitan areas: 3004-6627 Other areas: 0800-377-6627 / 0800-EPSONBR</td>
</tr>
<tr>
<td>Chile</td>
<td>(56 2) 2484-3400</td>
</tr>
<tr>
<td>Colombia</td>
<td>Bogota: (57 1) 592-2200 Other cities: 018000-915235</td>
</tr>
<tr>
<td>Costa Rica</td>
<td>800-377-6627</td>
</tr>
<tr>
<td>Dominican Republic*</td>
<td>1-888-760-0068</td>
</tr>
<tr>
<td>Ecuador*</td>
<td>1-800-000-044</td>
</tr>
<tr>
<td>Country</td>
<td>Telephone</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>El Salvador*</td>
<td>800-6570</td>
</tr>
<tr>
<td>Guatemala*</td>
<td>1-800-835-0358</td>
</tr>
<tr>
<td>Mexico</td>
<td>Mexico City: (52 55) 1323-2052</td>
</tr>
<tr>
<td></td>
<td>Other cities: 01-800-087-1080</td>
</tr>
<tr>
<td>Nicaragua*</td>
<td>00-1-800-226-0368</td>
</tr>
<tr>
<td>Panama*</td>
<td>00-800-052-1376</td>
</tr>
<tr>
<td>Paraguay</td>
<td>009-800-521-0019</td>
</tr>
<tr>
<td>Peru</td>
<td>Lima: (51 1) 418-0210</td>
</tr>
<tr>
<td></td>
<td>Other cities: 0800-10-126</td>
</tr>
<tr>
<td>Uruguay</td>
<td>00040-5210067</td>
</tr>
<tr>
<td>Venezuela</td>
<td>(58 212) 240-1111</td>
</tr>
</tbody>
</table>

* Contact your local phone company to call this toll-free number from a mobile phone.

If your country does not appear in the list, contact the sales office in the nearest country. Toll or long distance charges may apply.

**Purchase Supplies and Accessories**

You can purchase genuine Epson ink and paper from an Epson authorized reseller. To find the nearest reseller, visit epson.com.jm or call your nearest Epson sales office.

Parent topic: Solving Problems
Technical Specifications

These sections list the technical specifications for your product.

Windows System Requirements
Mac System Requirements
Paper Specifications
Printable Area Specifications
Scanning Specifications
Ink Specifications
Dimension Specifications
Electrical Specifications
Environmental Specifications
Interface Specifications
Safety and Approvals Specifications

Windows System Requirements

To use your product and its software, your computer should use one of these Microsoft operating systems:

• Windows 10
• Windows 8.x
• Windows 7
• Windows Vista
• Windows Server 2016
• Windows Server 2012 R2
• Windows Server 2012
• Windows Server 2008 R2
• Windows Server 2008
• Windows Server 2003 R2
• Windows Server 2003
• Windows Server 2003 SP2 or later
Windows Server supports only the printer driver and Epson Scan 2; any additional included software is not supported.

**Note:** For the latest product software available for your operating system, visit the Epson support site at epson.com.jm/support, select your product, and select **Downloads**.

**Parent topic:** Technical Specifications

## Mac System Requirements

To use your product and its software, your Mac should use one of these operating systems:

- macOS 10.13.x
- macOS 10.12.x
- OS X 10.11.x
- OS X 10.10.x
- OS X 10.9.x
- OS X 10.8.x
- OS X 10.7.x
- OS X 10.6.8

**Note:** For the latest product software available for your operating system, visit the Epson support site at epson.com.jm/support, select your product, and select **Downloads**.

**Parent topic:** Technical Specifications

## Paper Specifications

**Note:** Since the quality of any particular brand or type of paper may be changed by the manufacturer at any time, Epson cannot guarantee the quality of any non-Epson brand or type of paper. Always test a sample of paper stock before purchasing large quantities or printing large jobs.
Single-sheets

Size
- A4 (8.3 × 11.7 inches [210 × 297 mm])
- A6 (4.1 × 5.8 inches [105 × 148 mm])
- Letter (8.5 × 11 inches [216 × 279 mm])
- Legal (8.5 × 14 inches [216 × 356 mm])
- Executive (7.25 × 10.5 inches [184 × 267 mm])
- 8.5 × 13 inches (216 × 330 mm)
- Mexico-Oficio (8.5 × 13.4 inches [216 × 340 mm])
- Oficio 9 (8.46 × 12.4 inches [215 × 315 mm])
- 4 × 6 inches (102 × 152 mm)
- 5 × 7 inches (127 × 178 mm)
- 8 × 10 inches (203 × 254 mm)
- 16:9 wide (4 × 7.1 inches [102 × 181 mm])
- Half Letter (5.5 × 8.5 inches [140 × 216 mm])

Paper types
- Plain paper

Note: Your product also supports compatible papers distributed by Epson. See the link at the end of this topic for a list of compatible Epson papers.

Weight
- Plain paper: 17 lb (64 g/m²) to 24 lb (90 g/m²)

Envelopes

Size
- No. 10 (4.1 × 9.5 inches [105 × 241 mm])

Paper types
- Plain bond paper

Weight
- 20 lb (75 g/m²) to 24 lb (90 g/m²)

Parent topic: Technical Specifications
Related references
Compatible Epson Papers
Printable Area Specifications

Note: When printing borderless, quality may decline in the expanded printable area.

Single sheets

1. Top/bottom margins: 0.12 inch (3 mm)
2. Reduced print quality area/top: 1.61 inches (41 mm)
3. Reduced print quality area/bottom: 1.46 inches (37 mm)

Borderless
1 Reduced print quality area/top: 1.73 inches (44 mm)
2 Reduced print quality area/bottom: 1.57 inches (40 mm)

Envelopes

1 Left/right margins: 0.12 inch (3 mm)
2 Top/bottom margins: 0.20 inch (5 mm)
3 Reduced print quality area/right: 0.70 inch (18 mm)
4 Reduced print quality area/left: 1.61 inches (41 mm)

Parent topic: Technical Specifications

Scanning Specifications

<table>
<thead>
<tr>
<th>Scanner type</th>
<th>Flatbed, color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Photoelectric device</td>
<td>CIS</td>
</tr>
<tr>
<td>Document size</td>
<td>Maximum: 8.5 × 11.7 inches (216 × 297 mm)</td>
</tr>
<tr>
<td></td>
<td>Scanner glass: US letter or A4</td>
</tr>
<tr>
<td>Scanning resolution</td>
<td>600 dpi (main scan)</td>
</tr>
<tr>
<td></td>
<td>1200 dpi (sub scan)</td>
</tr>
</tbody>
</table>
Image data

- **Color:**
  - 48 bits per pixel (16 bits per pixel per color) internal
  - 24 bits per pixel (8 bits per pixel per color) external

- **Grayscale:**
  - 16 bits per pixel internal
  - 8 bits per pixel external

- **Black and white:**
  - 16 bits per pixel internal
  - 1 bit per pixel external

Light source

- **LED**

Parent topic: Technical Specifications

### Ink Specifications

**Note:** This product is designed to work with genuine Epson inks. Non-Epson ink or any other ink not specified for this printer could cause damage not covered by Epson’s warranties.

The ink bottles that are used for initial product setup have a lower yield due to the ink charging process. This process is carried out the first time you turn on the printer and guarantees better performance. Yields vary considerably based on print jobs, print settings, paper type, frequency of use, and temperature. Do not load paper before refilling the ink tanks.

Check the ink levels in your product frequently, and refill the ink tanks if necessary.

**Color**

- Black, Cyan, Magenta, Yellow

**Ink life**

- Do not use if the date on the package has expired

**Temperature**

- Storage: –4 to 104 °F (–20 to 40 °C)
- 1 month at 104 °F (40 °C)
- Ink freezes at 5 °F (–15 °C)
- Ink thaws and is usable after approximately 2 hours at 77 °F (25 °C)

Parent topic: Technical Specifications
Dimension Specifications

<table>
<thead>
<tr>
<th>Dimension</th>
<th>Stored</th>
<th>Printing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Height</td>
<td>7.0 inches (179 mm)</td>
<td>10.0 inches (253 mm)</td>
</tr>
<tr>
<td>Width</td>
<td>14.8 inches (375 mm)</td>
<td>14.8 inches (375 mm)</td>
</tr>
<tr>
<td>Depth</td>
<td>13.7 inches (347 mm)</td>
<td>22.8 inches (578 mm)</td>
</tr>
<tr>
<td>Weight</td>
<td>8.6 lb (3.9 kg)</td>
<td></td>
</tr>
</tbody>
</table>

(without ink or power cord)

Electrical Specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power supply rating</td>
<td>100 to 240 V</td>
</tr>
<tr>
<td>Rated frequency range</td>
<td>50/60 Hz</td>
</tr>
<tr>
<td>Rated current</td>
<td>0.4 to 0.2 A</td>
</tr>
<tr>
<td>Power consumption (with USB connection)</td>
<td>Standalone copying: Approximately 12 W (ISO/IEC24712)</td>
</tr>
<tr>
<td></td>
<td>Ready mode: Approximately 3.9 W</td>
</tr>
<tr>
<td></td>
<td>Sleep mode: Approximately 0.4 W</td>
</tr>
<tr>
<td></td>
<td>Power off mode: Approximately 0.2 W</td>
</tr>
</tbody>
</table>

Parent topic: Technical Specifications
Environmental Specifications

Temperature
- Operating: 50 to 95 °F (10 to 35 °C)
- Storage: –4 to 104 °F (–20 to 40 °C)
- 1 month at 104 °F (40 °C)

Humidity
- Operating: 20 to 80% RH (without condensation)
- Storage: 5 to 85% RH

Parent topic: Technical Specifications

Interface Specifications

Interface type
- Hi-Speed USB (Device Class for computers)

Parent topic: Technical Specifications

Safety and Approvals Specifications

United States
- Safety: UL60950-1
- EMC: FCC part 15 Subpart B class B

Canada
- Safety: CAN/CSA C22.2 No. 60950-1
- EMC: CAN/CSA-CEI/IEC CISPR 22 Class B

Parent topic: Technical Specifications
Notices

Check these sections for important notices about your product.

FCC Compliance Statement
Binding Arbitration and Class Waiver
Trademarks
Copyright Notice

FCC Compliance Statement

For United States Users
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio or television reception. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause interference to radio and television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

WARNING
The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC Certification or Declaration of this device and may cause interference levels which exceed the limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this device. If this equipment has more than one interface connector, do not leave cables connected to unused interfaces. Changes or modifications not expressly approved by the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users
CAN ICES-3(B)/NMB-3(B)

Parent topic: Notices
1. DISPUTES, BINDING INDIVIDUAL ARBITRATION, AND WAIVER OF CLASS ACTIONS AND CLASS ARBITRATIONS

1.1 Disputes. The terms of this Section 1 shall apply to all Disputes between you and Epson. The term "Dispute" is meant to have the broadest meaning permissible under law and includes any dispute, claim, controversy or action between you and Epson arising out of or relating to this Agreement, Epson branded products (hardware and including any related software), or other transaction involving you and Epson, whether in contract, warranty, misrepresentation, fraud, tort, intentional tort, statute, regulation, ordinance, or any other legal or equitable basis. "DISPUTE" DOES NOT INCLUDE IP CLAIMS, or more specifically, a claim or cause of action for (a) trademark infringement or dilution, (b) patent infringement, (c) copyright infringement or misuse, or (d) trade secret misappropriation (an "IP Claim"). You and Epson also agree, notwithstanding Section 1.6, that a court, not an arbitrator, may decide if a claim or cause of action is for an IP Claim.

1.2 Binding Arbitration. You and Epson agree that all Disputes shall be resolved by binding arbitration according to this Agreement. ARBITRATION MEANS THAT YOU WAIVE YOUR RIGHT TO A JUDGE OR JURY IN A COURT PROCEEDING AND YOUR GROUNDS FOR APPEAL ARE LIMITED. Pursuant to this Agreement, binding arbitration shall be administered by JAMS, a nationally recognized arbitration authority, pursuant to its code of procedures then in effect for consumer related disputes, but excluding any rules that permit joinder or class actions in arbitration (for more detail on procedure, see Section 1.6 below). You and Epson understand and agree that (a) the Federal Arbitration Act (9 U.S.C. §1, et seq.) governs the interpretation and enforcement of this Section 1, (b) this Agreement memorializes a transaction in interstate commerce, and (c) this Section 1 shall survive termination of this Agreement.

1.3 Pre-Arbitration Steps and Notice. Before submitting a claim for arbitration, you and Epson agree to try, for sixty (60) days, to resolve any Dispute informally. If Epson and you do not reach an agreement to resolve the Dispute within the sixty (60) days, you or Epson may commence an arbitration. Notice to Epson must be addressed to: Epson America, Inc., ATTN: Legal Department, 3840 Kilroy Airport Way, Long Beach, CA 90806 (the "Epson Address"). The Dispute Notice to you will be sent to the most recent address Epson has in its records for you. For this reason, it is important to notify us if your address changes by emailing us at EAILegal@ea.epson.com or writing us at the Epson Address above. Notice of the Dispute shall include the sender's name, address and contact information, the facts giving rise to the Dispute, and the relief requested (the "Dispute Notice"). Following receipt of the Dispute Notice, Epson and you agree to act in good faith to resolve the Dispute before commencing arbitration.

1.4 Small Claims Court. Notwithstanding the foregoing, you may bring an individual action in the small claims court of your state or municipality if the action is within that court's jurisdiction and is pending only in that court.
1.5 WAIVER OF CLASS ACTIONS AND CLASS ARBITRATIONS. YOU AND EPSON AGREE THAT EACH PARTY MAY BRING DISPUTES AGAINST THE OTHER PARTY ONLY IN AN INDIVIDUAL CAPACITY, AND NOT AS A PLAINTIFF OR CLASS MEMBER IN ANY CLASS OR REPRESENTATIVE PROCEEDING, INCLUDING WITHOUT LIMITATION FEDERAL OR STATE CLASS ACTIONS, OR CLASS ARBITRATIONS. CLASS ACTION LAWSUITS, CLASS-WIDE ARBITRATIONS, PRIVATE ATTORNEY-GENERAL ACTIONS, AND ANY OTHER PROCEEDING WHERE SOMEONE ACTS IN A REPRESENTATIVE CAPACITY ARE NOT ALLOWED. ACCORDINGLY, UNDER THE ARBITRATION PROCEDURES OUTLINED IN THIS SECTION, AN ARBITRATOR SHALL NOT COMBINE OR CONSOLIDATE MORE THAN ONE PARTY'S CLAIMS WITHOUT THE WRITTEN CONSENT OF ALL AFFECTED PARTIES TO AN ARBITRATION PROCEEDING.

1.6 Arbitration Procedure. If you or Epson commences arbitration, the arbitration shall be governed by the rules of JAMS that are in effect when the arbitration is filed, excluding any rules that permit arbitration on a class or representative basis (the "JAMS Rules"), available at https://www.jamsadr.com/about/ or by calling +1-949-224-1810 (from outside the U.S.) or 1-800-352-5267 (from within the U.S.), and under the rules set forth in this Agreement. All Disputes shall be resolved by a single neutral arbitrator, and both parties shall have a reasonable opportunity to participate in the selection of the arbitrator. The arbitrator is bound by the terms of this Agreement. The arbitrator, and not any federal, state or local court or agency, shall have exclusive authority to resolve all disputes arising out of or relating to the interpretation, applicability, enforceability or formation of this Agreement, including any claim that all or any part of this Agreement is void or voidable. Notwithstanding this broad delegation of authority to the arbitrator, a court may determine the limited question of whether a claim or cause of action is for an IP Claim, which is excluded from the definition of "Disputes" in Section 1.1 above. The arbitrator shall be empowered to grant whatever relief would be available in a court under law or in equity. The arbitrator may award you the same damages as a court could, and may award declaratory or injunctive relief only in favor of the individual party seeking relief and only to the extent necessary to provide relief warranted by that party's individual claim. In some instances, the costs of arbitration can exceed the costs of litigation and the right to discovery may be more limited in arbitration than in court. The arbitrator's award is binding and may be entered as a judgment in any court of competent jurisdiction.

You may choose to engage in arbitration hearings by telephone. Arbitration hearings not conducted by telephone shall take place in a location reasonably accessible from your primary residence, or in Orange County, California, at your option.

a) Initiation of Arbitration Proceeding. If either you or Epson decides to arbitrate a Dispute, both parties agree to the following procedure:

(i) Write a Demand for Arbitration. The demand must include a description of the Dispute and the amount of damages sought to be recovered. You can find a copy of a Demand for Arbitration at http://www.jamsadr.com ("Demand for Arbitration").

(ii) Send three copies of the Demand for Arbitration, plus the appropriate filing fee, to: JAMS, 500 North State College Blvd., Suite 600 Orange, CA 92868, U.S.A.
(iii) Send one copy of the Demand for Arbitration to the other party (same address as the Dispute Notice), or as otherwise agreed by the parties.

b) Hearing Format. During the arbitration, the amount of any settlement offer made shall not be disclosed to the arbitrator until after the arbitrator determines the amount, if any, to which you or Epson is entitled. The discovery or exchange of non-privileged information relevant to the Dispute may be allowed during the arbitration.

c) Arbitration Fees. Epson shall pay, or (if applicable) reimburse you for, all JAMS filings and arbitrator fees for any arbitration commenced (by you or Epson) pursuant to provisions of this Agreement.

d) Award in Your Favor. For Disputes in which you or Epson seeks $75,000 or less in damages exclusive of attorney's fees and costs, if the arbitrator's decision results in an award to you in an amount greater than Epson's last written offer, if any, to settle the Dispute, Epson will: (i) pay you $1,000 or the amount of the award, whichever is greater; (ii) pay you twice the amount of your reasonable attorney's fees, if any; and (iii) reimburse you for any expenses (including expert witness fees and costs) that your attorney reasonably accrues for investigating, preparing, and pursuing the Dispute in arbitration. Except as agreed upon by you and Epson in writing, the arbitrator shall determine the amount of fees, costs, and expenses to be paid by Epson pursuant to this Section 1.6d).

e) Attorney's Fees. Epson will not seek its attorney's fees and expenses for any arbitration commenced involving a Dispute under this Agreement. Your right to attorney's fees and expenses under Section 1.6d) above does not limit your rights to attorney's fees and expenses under applicable law; notwithstanding the foregoing, the arbitrator may not award duplicative awards of attorney's fees and expenses.

1.7 Opt-out. You may elect to opt-out (exclude yourself) from the final, binding, individual arbitration procedure and waiver of class and representative proceedings specified in this Agreement by sending a written letter to the Epson Address within thirty (30) days of your assent to this Agreement (including without limitation the purchase, download, installation of the Software or other applicable use of Epson Hardware, products and services) that specifies (i) your name, (ii) your mailing address, and (iii) your request to be excluded from the final, binding individual arbitration procedure and waiver of class and representative proceedings specified in this Section 1. In the event that you opt-out consistent with the procedure set forth above, all other terms shall continue to apply, including the requirement to provide notice prior to litigation.

1.8 Amendments to Section 1. Notwithstanding any provision in this Agreement to the contrary, you and Epson agree that if Epson makes any future amendments to the dispute resolution procedure and class action waiver provisions (other than a change to Epson's address) in this Agreement, Epson will obtain your affirmative assent to the applicable amendment. If you do not affirmatively assent to the applicable amendment, you are agreeing that you will arbitrate any Dispute between the parties in accordance with the language of this Section 1 (or resolve disputes as provided for in Section 1.7, if you timely elected to opt-out when you first assented to this Agreement).
1.9 **Severability.** If any provision in this Section 1 is found to be unenforceable, that provision shall be severed with the remainder of this Agreement remaining in full force and effect. The **foregoing shall not apply to the prohibition against class or representative actions as provided in Section 1.5. This means that if Section 1.5 is found to be unenforceable, the entire Section 1 (but only Section 1) shall be null and void.**

**Parent topic:** Notices

### Trademarks

EPSON® is a registered trademark and EPSON Exceed Your Vision is a registered logomark of Seiko Epson Corporation.

Windows is a registered trademark of Microsoft Corporation in the United States and/or other countries.

Apple, Mac, macOS, and OS X are trademarks of Apple Inc., registered in the U.S. and other countries.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. Epson disclaims any and all rights in those marks.

---

**Parent topic:** Notices

### Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko Epson Corporation. The information contained herein is designed only for use with this Epson product. Epson is not responsible for any use of this information as applied to other products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or any consumable products other than those designated as Original Epson Products or Epson Approved Products by Seiko Epson Corporation.
Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic interference that occurs from the use of any interface cables other than those designated as Epson approved Products by Seiko Epson Corporation. This information is subject to change without notice.

**libTIFF Software Acknowledgment**

Copyright © 1988-1997 Sam Leffler


Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby granted without fee, provided that (I) the above copyright notices and this permission notice appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

**A Note Concerning Responsible Use of Copyrighted Materials**

Epson encourages each user to be responsible and respectful of the copyright laws when using any Epson product. While some countries’ laws permit limited copying or reuse of copyrighted material in certain circumstances, those circumstances may not be as broad as some people assume. Contact your legal advisor for any questions regarding copyright law.

**Parent topic:** Copyright Notice
Copyright Attribution

© 2020 Epson America, Inc.
4/20
CPD-55457R1

Parent topic: Copyright Notice